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RESUMEN

El presente documento surge como resultado de un curso avanzado y especifico de entrenamiento, realizado durante
dos semanas dentro del marco del proyecto DevCoCast, en la Facultad del ITC de la Universidad de Twente, en
Enschede, Paises Bajos, en febrero de 2011.

Mias de 30 investigadores de diversas universidades africanas, latinoamericanas y europeas, de centros de
entrenamiento e investigacién sobre el espacio y de proyectos de colaboracion internacionales entre Europa y Aftica
patticiparon en el curso. La mayoria de los participantes ya habia asistido a talleres y cursos de entrenamiento
previos, también realizados dentro del marco del proyecto DevCoCast en Africa, algunos en conjunto con AMESD,
y en América Latina. El principal objetivo del curso fue, luego de que los participantes hubieran adquirido un robusto
conocimiento practico, desarrollar aplicaciones que permitan demostrar el uso de la informacién diseminada a través
de GEONETCast, un sistema de diseminacion que utiliza satélites de telecomunicacién (transmisién), y mas
especificamente, de aquella informacién diseminada a través del canal DevCoCast, dentro de dicho sistema.

Luego de un capitulo introductorio que describe el sistema GEONETCast y el rol del proyecto DevCoCast, en los
siguientes capitulos se destacan aplicaciones desarrolladas por los participantes durante el curso, utilizando
observaciones in situ en los casos que fuera posible y asociando las mismas al andlisis y procesamiento de diversas
imdgenes satelitales y productos detivados. Los campos de aplicacién incluyen la evaluacion de vegetacion, biomasa y
practicas agricolas, conservacién de habitats, monitoreo de insectos plaga, estimaciones de precipitacién y
evapotranspiracion, deteccién de focos de incendios, monitoreo de sequias e incluso, algunas aplicaciones en
ambientes marinos. Las 4reas de estudio seleccionadas pertenecen a Sudamérica y a las zonas sur y este de Africa.

El objetivo general del presente manual es, ademds de demostrar las ventajas de usar datos de distribucion libre
diseminados a través del sistema GEONETCast, el cual es confiable y econémico, hacer disponible una serie de
ejercicios que pueden ser usados en institutos de educacién superior, dentro del contenido curricular de diversas
disciplinas, o por personas interesadas en el tema.

Los capitulos describen de forma estructurada los diferentes pasos de (pre) procesamiento y analisis, siguiendo una
metodologia descripta claramente para los distintos dominios de aplicacion, cuyo orden se decidi6 al azar. De manera
de profundizar la metodologfa descripta e ilustrar los resultados de los ejercicios, se encuentran disponibles
presentaciones en Powerpoint. Para realizar los ejercicios, es necesario instalar ILWIS372 y el agregado (plug-in)
llamado “GEONETCast toolbox”. Ambas utilidades pueden obtenerse gratuitamente y ser descargadas de
http://52north.org, junto con un manual del usuario para su instalacién y primer uso.

Todo el material relacionado (manual completo, presentaciones suplementarias en powerpoint y datos de
ejemplificacion) pueden descargarse libremente y en forma comprimida de

ftp://ftp.itc.nl/pub/52n/eonc_devcocast applications/.

Esperamos que este documento y los ejercicios que contiene sean de utilidad para integrar en la practica diaria de la
comunidad de usuarios la informacion provista a través de GEONETCast y DevCoCast. Si usted estuviera
interesado en entregar un nuevo ejercicio relativo a su propio dominio de aplicacién, por favor no dude en

contactarse con los editores del presente manual de aplicaciones.

Ben Maathuis y Chris Mannaerts
Departamento de Recursos Hidricos
Facultad ITC — Universidad de Twente
Enschede, Paises Bajos

Septiembre 2011
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1. INTRODUCCION A GEONETCAST Y AL PROYECTO
DEVCOCAST

Por: Cesar de Mello!, Matthew Medland y Mike Grant2, Tim Jacobs?

11. GEO y GEONETCast

El Grupo de Observacion Terrestre (GEO) es una organizacién intergubernamental establecida en mayo de 2005.
GEO incentiva la coordinacion de los sistemas de observacion tetrestre en vatios paises, promueve el concepto de
constituir un Sistema de Sistemas de Observaciéon Terrestre (GEOSS), que brindard una amplia variedad de

beneficios sociales, como por ejemplo:

e reducir la pérdida de vidas y propiedades ocasionadas por desastres naturales y antropogénicos;

e comprender los factores ambientales que afectan el bien estar y la salud de los seres humanos;

® mejorar el manejo de los recursos energéticos;

e  comprender, evaluar, predecir, mitigar, y adaptarse al cambio y variabilidad climdtica;

e  optimizar el manejo de los recursos hidricos a través de un mejor entendimiento del ciclo del agua;
e mejorar la informacién, pronéstico y alertas meteoroldgicas;

e mejorar el manejo y la proteccién de los ecosistemas terrestres, costeros y marinos;

e apoyar la agricultura sustentable y combatir la desertificacion;

e ycomprender, monitorear y conservar la biodiversidad.

Desde 2011 la Comisién Europea y 86 Gobiernos forman parte de GEO como miembros. Ademas, han sido
reconocidas como organizaciones participantes de GEO 61 organizaciones intergubernamentales, internacionales y
regionales encargadas de actividades relacionadas a la Observaciéon Terrestre. En la actualidad, GEO se ha
convertido en la mayor organizacién internacional en el campo de la Observacién Terrestre. Para mas informacién

sobte GEO, consulte: http://www.earthobservations.otg.

Figura 1.1 Ceremonia de inauguracion de GEO en Ia sede central de Ia UN en Washington DC

1 CPTEC-INPE, cesar.mello@cptec.inpe.br (Autor Correspondiente)

2 Plymouth Marine Laboratory (PML)
3 Flemish Institute for Technological Research NV (VITO)
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Una de las tareas mas importantes de GEO, y sobre la cual se han realizado grandes avances, es promover el
intercambio de datos provenientes de Observacion Terrestre (EO, por sus siglas en inglés). Uno de estos logros es la
creaciéon de GEONETCast, una red global de sistemas de difusién de datos, basados en la transmision por satélites
de telecomunicacién, que comparte datos ambientales y productos derivados de la observacion terrestre a una
comunidad de usuarios mundial en tiempo casi real. La red GEONETCast, parte de la infraestructura central de
GEOSS, permite el acceso a mas de 100 productos e imagenes de Observacion Terrestre (EO) producidos por 35
proveedores de distintas partes del mundo, a bajo costo, escala global y de manera fiable. La red consta de tres
transmisiones regionales, y un cuarto componente (el Mitra de Rusia) que se encuentra en proceso de incorporacion:
e BEUMETCast: operado por la Organizacion Europea para el uso de Satélites Meteoroldgicos
(EUMETSAT), cubriendo Eutopa, Affica, partes de Asia y América;
e CMACast: operado por la Administracién Meteoroldgica de China (CMA), cubriendo Asia y partes del
Pacifico (un avance considerable sobre el anterior sistema: FengYunCast);
e  GEONETCast-Americas: operado por la Administracién Nacional Atmosférica y Oceanica de los Estados
Unidos de América NOAA), cubriendo el continente Americano y el Caribe.
Los tres operadores principales, NOAA, EUMETSAT y CMA, son llamados GEONETCast Networking Centres
(GNC). La cobertura de GEONETCast se ilustra en la Figura 1.2. Los principales proveedores de datos satelitales y
productos derivados del sistema GEONETCast se detallan en la Tabla 1.1.

EUMETCast Europe
FLNETSAT

Figura 1.2 Cobertura del sistema GEONETCast

EUMETSAT y su red Instalaciones de Datos satelitales del Meteosat (cada 15 minutos), Jason y MetOp (por cada pasada local del

Aplicaciones Satelitales (SAFs) satélite). Productos meteoroldgicos para aplicaciones atmosféricas, terrestres y marinas.

NOAA Datos satelitales de GOES y POES y productos NOAA-NESDIS para aplicaciones atmosféricas
y marinas.

CMA Datos satelitales del FengYun (FY 1/2/3)

VITO Varios productos derivados del SPOT-Vegetation para aplicaciones terrestres.

ECMWEF/ U.K. Met Office, Deutscher

. o Productos obsetvacionales y de prondstico para aplicaciones atmosféricas, terrestres y marinas.
Wetterdienst, Météo-France

Tabla 1.1 GEONETCast — proveedores principales de informacion satelital y productos derivados

Accediendo al “Product Navigator” operado por EUMETSAT, disponible en su pagina web
(http://www.cumetsat.int) se puede obtener una lista actualizada de los productos y datos disponibles.

2
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1.2. El proyecto DevCoCast

1.2.1. Introduccion

Muchos paises en desarrollo y economias emergentes (China, Brasil) enfrentan serios riesgos medioambientales y
necesitan acceso a datos e informacién ambiental precisa y confiable, derivada de la Observacion Terrestre (EO),
para su desatrollo sustentable. El proyecto GEONETCast para y por Paises en Desarrollo (DevCoCast),
financiado por el 7m° Programa Marco de la Comunidad Europea para la Investigacién y el Desarrollo Tecnolégico
(FP7), involucra a pafses en desarrollo en la iniciativa de GEONETCast. DevCoCast usa GEONETCast para
diseminat datos ambientales con valor agregado (tanto de origen in-situ como satelital) provenientes de varios paises
de Africa, Sudamérica, América central, Asia y Europa a un amplio espectro de usuatios finales de paises en
desarrollo. Para mejorar la organizacién del flujo de productos, DevCoCast establece centros de concentracién y
redistribucién (hubs) para datos marinos y terrestres que se integran fluidamente en la red de GEONETCast. Al
mismo tiempo, la red de receptores satelitales es expandida en Sudamérica para la recepcion de datos, como también
para la investigacién marina y los servicios de control de la langosta del desierto en Africa y para un GEONETCast

piloto de intercambio de datos con China de apoyo a los servicios de informacion marina.

GEONETCast
Asia

ﬂ Diseminacion de datos

¢ Estacién receptora

A
-

4
‘;} / .‘ Proveedor de datos

11 é Hubs

@ EUMETcast GNC

Area de cobertura

Figura 1.3 Mapa para una vision general de DevCoCast

Ademids, se realizan entrenamientos que permiten mantener y mejorar las capacidades y redes existentes, de manera
de apoyar el uso real de los productos por parte de la creciente comunidad de usuarios. Esto se realiza en los
distintos continentes y sobre diversos temas de aplicacién como vegetacioén y agricultura, incendios, inundaciones,
recursos hidricos, recursos matinos, tiempo y clima. El objetivo es introducir e integrar GEONETCast y los
productos ofrecidos en los programas educativos, la investigacion, el monitoreo ambiental y la toma de decisiones,

para apoyar el desarrollo sostenible.

1.2.2. Ventajas derivadas del uso del sistema de transmisién GEONETCast.

Si bien la mayorfa de los receptores se encuentran actualmente en Europa y China, el sistema de transmisién es
particularmente 1til en pafses en desarrollo, donde puede ayudar a evitar el alto costo de mantener una conexién a
Internet fiable con la capacidad suficiente de transmitir la gran cantidad de productos de observacion terrestre (p. ¢j.

fuera de las grandes ciudades). Otras ventajas son:
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* La disponibilidad de equipos receptores de bajo costo;

* La alta fiabilidad y tasa de transferencia de datos;

* La gran variedad de imdgenes y productos disponibles gratuitamente;

* El compromiso a largo plazo para mantener la infraestructura, en particular de EUMETSAT hacia Africa;
* La red del receptores en constante crecimiento, asi como el creciente nimero de productos y proveedores
de datos.

Con GEONETCast los usuarios no necesitan construir repetidamente distintas estaciones terrenas de recepcion para

cada satélite ya que el sistema permite la retransmision de datos de diferentes proveedores a través de satélites de

telecomunicacion. Para acceder a los datos es necesario un receptor similar a los de TV o internet satelital.

123.

Miembros de DevCoCast y establecimiento de una red abierta

El proyecto DevCoCast es coordinado por el Instituto Flamenco de Investigacién Tecnolégica NV (VITO), Bélgica.

Ademas de VITO, otras 14 organizaciones de Africa (4), Sudamérica (4) y Europa (6) forman un equipo para hacer

de DevCoCast un éxito. Para coordinar el proyecto, VITO dirige el Comité Directivo (Steering Group) compuesto

por nueve miembros, tres de cada continente. Las organizaciones que colaboran con DevCoCast son:

Instituto Flamenco de Investigacién Tecnolégica NV (VITO), Bélgica

Centro Africano de Aplicaciones Meteoroldgicas para el Desarrollo (ACMAD), Niger

Centro Regional de Entrenamiento y Aplicaciones Operacionales en Agro-meteorologia e¢ Hidrologia
(AGRHYMET), Niger

Agencia de Provisién de Alimentos del Ministerio de Agricultura (CONAB), Brasil

Centro de Relevamiento y Evaluacién de Recursos Agticolas y Naturales (CREAN), Argentina

Consejo para la Investigacién Cientifica e Industrial — Instituto Meraka (CSIR), Sudafrica

Instituto Meteorologico Danés (DMI), Dinamarca

Organizacién Europea para el uso de Satélites Meteorologicos (EUMETSAT), Alemania

Instituto Nacional de Investigacién del Espacio (INPE), Brasil

Instituto Nacional de Tecnologia Agropecuaria (INTA), Argentina

Universidad de Twente - Facultad de Ciencias de Geo-Informacién y Observacion Terrestre (ITC), Paises
Bajos

Comision Europea — Centro Conjunto de Investigacion DG — Instituto para el Ambiente y la
Sustentabilidad (JRC), Italia

Consejo de Investigacion del Ambientes Naturales — Centro Nacional Oceanografico de Southampton
(NOCS), Reino Unido

Instituto de Investigaciones Marinas — Universidad de la Ciudad del Cabo (MRSU, UCT), Sudafrica
Laboratotio Marino de Plymouth (PML), Reino Unido

Ademids de estos miembros (partners), otras 10 instituciones recibieron una estacién receptora financiada por

DevCoCast, e instalada por (o con la ayuda de) alguna de las organizaciones miembro (partners). Se espera de ellas

que informen el impacto que tiene GEONETCast en su trabajo cotidiano. Dichas instituciones asociadas son:

Corporacién de Investigaciéon en Agricultura Brasilera (EMBRAPA), centro de Monitoreo Satelital
(CNPM), Brasil
Universidad del Estado de Campinas, Facultad de Ingenierfa Agronémica (FEAGRI), Brasil
Cuatro Institutos de Investigaciéon Marina
0  Universidad Cheikh Anta Diop, Laboratotio de Entrenamiento en Geomatica (LERG), Senegal
0  Universidad de Dar es Salaam, Instituto de Ciencias Marinas (IMS), Tanzania
0 Ministerio de Pesquerias y Recursos Marinos, Centro Nacional de Investigacién e Informacién
Marina (NatMIRC), Namibia
0  Universidad de Ghana (UG)
Oficinas y Centros Nacionales de Control de Langosta de Mali (CNLCP), Sudan y Eritrea
Jiangyin Tecnologia Marina Co. Ltd. (JYMT), China
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El nimero de organizaciones que forman parte o estan relacionadas a DevCoCast es ain mas grande que la suma de
los miembros del consorcio e instituciones receptoras. DevCoCast sitve de conector y ayuda mantener la red de
EUMETCast en Brasil (con alrededor de 50 organizaciones), la red AMESD en Aftica (que incluye todos los
Servicios Meteorologicos Nacionales de los paises sub-Saharianos y varios Ministerios Nacionales de Ambiente y
Agricultura), la Red Sudafricana de Incendios (SAFNET) integrada por bomberos y administradores, organizaciones
internacionales como UN-FAO y muchas otras redes de estaciones receptoras y usuarios de GEONETCast (¢j. FP7-
Geoland2/FP6-VGT4Africa, ChloroGIN, FP6-YEOS), asi como redes de entrenamiento (EUMETSAT, ITC).
Todo esto significa que la comunidad de usuarios nuclea a cientos de expertos en EO. Por ejemplo, la red de
usuarios de productos de SPOT-VEGETATION ha pasado de tener alrededor de 100 usuarios a fines del 2007 (en
Africa; informe final de VGT4Africa, 2008) a mas de 300 usuatios en la actualidad (en Africa y Sudamérica).

Para hacer esto posible, DevCoCast, desde un principio, se construyé sobre redes existentes y mantiene una apertura
total hacia la incorporacién de nuevas organizaciones dispuestas a usar GEONETCast, tanto como proveedores de

productos o como usuatios/teceptores.

1.2.4. Metodologia y resultados del Proyecto

El proyecto DevCoCast tiene cuatro actividades principales:

1. Compartir productos EO (algunos originados en Africa y Sudamérica) a nivel continental y mundial, usando
EUMETCast y el sistema piloto GEONETCast de intercambio de datos. Esta actividad incluye una
revisiéon y armonizacioén de los productos con el objetivo de simplificar su uso. En el Apéndice 1 se detalla
una lista de productos.

2. Extender la infraestructura existente mediante el agregado de nodos terrestres y marinos a la red central de
GEONETCast, operada por EUMETSAT, que prioricen y programen los productos de EO entrantes antes
de ser enviarlos a EUMETSAT para su difusion. Ademads, se estan agregando y mejorando varias estaciones
receptoras en Africa (7), Sudamérica (6) y China (1).

3. Desarrollar capacidades mediante el apoyo y formacion de usuatios a través de varios talleres
(internacionales), servicios de informacioén y asistencia, médulos de capacitacién independiente, utilizando
como base las redes de formacion existentes.

4. Por dltimo, mejorar y mantener las capacidades y redes existentes de manera de integrar GEONET Cast y

los productos que ofrece en la educacién, investigacién, monitoreo ambiental y la toma de decisiones.

Con productos de casi cada uno de los diez proveedores de DevCoCast (ver Anexo 1) que se transmiten a través de
los Centros de concentracién y redistribuciéon de informacion terrestre y matina (hubs) y con casi todas las estaciones
receptoras instaladas y en funcionamiento, las dos primeras actividades basicas estin muy cerca de su finalizacién. Se
han organizado varios talleres exitosos, con mas de 300 participantes, utilizando softwate libre y material didactico
desarrollado con el objetivo de gestionar y procesar los datos difundidos por GEONETCast. Este matetial,
incluyendo el presente documento, serd disponible gratuitamente en varios idiomas. El proyecto ha alcanzado la
ultima etapa y la mas importante: demostrar el uso y beneficio real de GEONETCast a la comunidad de usuarios, en
los diferentes temas de aplicacién, con lo que se espera lograr un aumento en la utilizacién de GEONETCast en
Africa, América del Sur y el Sudeste Asiatico.

La puesta en marcha del proyecto Europe-Africa Marine Network (EAMNET, FP7) garantizan la continuidad, el
desarrollo de actividades de formacién y una utilizacion eficaz de GEONETCast para aplicaciones marinas en Africa.
El nuevo proyecto AGRICAB (también financiado por el FP7), que se inicia en asociacion con DevCoCast asegura,
ademads, la continuidad del uso de los datos y productos de GEONETCast en aplicaciones tetrestres (agricultura,

silvicultura) en el continente africano.
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13. EUMETCast

1.3.1. Introduccién

Para la transmision de la amplia variedad de productos de DevCoCast, provenientes de 10 fuentes distintas, a cientos
de receptores / usuarios en Africa, América del Sur y China, el proyecto utiliza y extiende la transmisién de
EUMETCast, operado por EUMETSAT, lo cual es uno de los principales componentes de GEONETCast. Esto
incluye:

e contratar ancho de banda de transmisiéon de dedicacion exclusiva (el canal DEVCOCAST-1);

e actualizar la configuracién de los sistemas de diseminacion EUMETCast - EUMETSAT;

e afladir datos al sistema EUMETCast-CMACast de intercambio de datos para la difusién (demostracion) en

China;
ey apoyar la instalaciéon de nuevas estaciones de recepciéon de GEONETCast proveyendo asesoramiento y

soporte remoto a los usuarios cuando es necesario.

El sistema EUMETCast es un sistema de multidifusién que utiliza la tecnologia estindar de Transmisién Digital de
Video (Digital Video Broadcast, DVB) para el transporte de paquetes de datos (datagramas IP) a través de un
conjunto de satélites geoestacionarios de telecomunicacion, que se utilizan también para Internet y television satelital.
Esto se realiza sobtre un sistema cliente / servidor, con el setvidor implementado en el sitio de enlace ascendente
(uplink) de EUMETCast y el cliente instalado en las multiples estaciones individuales de recepcion. Los componentes
que intervienen son:

e Proveedores de datos

e Gestores de servicio

e Proveedores de servicio de enlace ascendente (uplink)

e Proveedores del servicio de retransmisién (turn around)

e Satélites

e  Kstaciones receptoras

gt
’EH AHonHcBid-3
- w
LR T . T
Datos de % 4 %
EUMETSAT | .
i Enlace Servicio de
g | @ascendente : Usuari Turnaround
Datos de o Europa suariosen Africa Usuariosen
. H Europa P
proveedores Africa

#‘ Newlicles-00%
~ "v

Servicio de
Turnaround .
Améri Usuariosen
merica América

Figura 1.4 Arquitectura del sistema EUMETCast

Para la transmision, los productos propios y externos de EUMETSAT son transferidos como archivos a través de
lineas de transmisién dedicadas desde EUMETSAT a la estacion de enlace ascendente (uplink facility). La estacién
luego codifica y transmite los archivos a los satélites de telecomunicacién para su difusiéon (usando un grupo de
canales) hacia las estaciones receptoras. Cada receptor decodifica la sefial y recrea los datos/productos. Asi, una
estaciéon de recepcién puede recibir cualquier combinacién de los servicios de datos proporcionados por
EUMETCast, de acuerdo con la politica de informacién particular y luego de haberse registrado para obtener la

licencia (por lo general sin costo) de acceso a los datos/productos.

6
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1.3.2. Caracteristicas técnicas de EUMETCast

Ademis de las ventajas generales de GEONET Cast (ver seccion 1.3), EUMETCast se catractetiza por:

e Entrega segura, la cual permite una difusién multiple dirigida a un usuario especifico o grupo de usuarios,
por lo tanto soporta cualquier politica de distribucién de datos;

e Manejo de cualquier formato de archivos, lo que permite la difusién de una amplia gama de productos;

e  Eluso de servicios de retransmision de DVB permite una sencilla ampliacién de la cobertura geografica;

e Los usuarios pueden recibir maltiples canales de datos a través de una sola estacion de recepcion basada en
equipos con plataforma DVB disponible a gran escala en el mercado;

e Una base de usuarios instalados con mas de 1700 estaciones receptoras;

e Una arquitectura de sistema que permite facilmente cambios en la escala.

1.3.2.1. Uplink, Turnaround y Proveedores de datos

El servicio de enlace ascendente (Uplink) realiza las siguientes tareas:

e Recibe todos los datos que se transmiten de todos los proveedores de datos;

e Coordina todas las transmisiones acorde a la configuracioén del sistema;

e Codifica los datos de acuerdo a la configuracion del sistema de diseminacién del usuario;

e Aplica el Forward Error Correction (FEC) a los datos multicanales (las técnicas FEC transmiten
informacién redundante adicional para permitir que los receptores cottijan un cierto grado de pérdida de
datos, sin necesidad de tetransmision);

o Convierte los archivos al formato de DVB;

e  Transmiten la sefal utilizando satélites comerciales;

e  Recibe los datos multicanales en una estacién receptora de referencia para realizar un servicio de monitoreo.

Para EUMETCast, el sistema de multidifusién proporcionado por T-Systems GmbH, se basa en un sistema cliente/
servidor desarrollado por Tellitec, con el servidor implementado en el sitio del enlace ascendente EUMETCast en
Usingen (Alemania). El cliente esta instalado en todas las estaciones de recepcion EUMETCast. Hay una serie de
proveedores de datos, incluyendo EUMETSAT mismo, que entregan archivos en el sitio de enlace ascendente a
través de FTP usando varias lineas de comunicacion.

El proveedor del servicio de retransmisién (turnaround) recibe la sefial de DVB de un satélite y la retransmite, sin
abrir los paquetes de datos, a otro satélite. Telespazio S.p.A. oftrece el servicio de retransmision de la banda C para
EUMETCast Africa desde su sitio de enlace ascendente en Fucino (Italia) y GlobeCast ofrece el servicio
retransmisién de la banda C para EUMETCast-Américas a partir de su instalacion de enlace ascendente en Paris

(Francia).

1.3.2.2. Multidifusién a usuarios especificos a través de la Codificacién/Decodificacion de Datos

El sistema EUMETCast permite que los archivos sean dirigidos independientemente a un solo usuatio o grupo de
usuatios, permitiendo un control seguro del acceso a los datos nivel de archivo individual y de usuario individual. El
cifrado de los datos se realiza mediante el enlace ascendente EUMET Cast y el descifrado por el Software de Cliente
EUMETCast instalado en la estaciéon receptora. La mayoria de los datos y productos estan cifrados con la clave de
usuatio (contrasefia) del usuario de destino, por lo que sélo estan disponible cuando el usuario se ha registrado para
recibirlos y se le ha concedido acceso (una licencia, por lo general sin costo) de acuerdo con la politica de uso de los
datos que esté en vigencia (por ejemplo, Data Policy for the EUMETSAT data and products). El requisito de registro
también ofrece a los proveedores una visién clara del nimero de estaciones de recepcion EUMETCast que se han
registrado para usar sus productos, promoviendo el envio continuo. La registracién puede realizarse en linea, usando
el Portal de Observacion Terrestre de EUMETSAT (disponible en

http://www.eumetsat.int/Home/Main/DataAccess/ EOPortal/index.htm?l=en).

Para habilitar el descifrado correspondiente por parte del “Software de Cliente EUMETCast” del receptor, la
estaciéon del usuario tendrd que estar equipada con una EUMETCast Key Unit (EKU). La EKU se conecta
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simplemente a través de USB, EUMETSAT gestiona la distribucién de los dispositivos EKU hacia los usuarios

registrados.

1.3.2.3. Gestion del servicio y Directorios de Servicio

La gestion del servicio es realizada por EUMETSAT, quien provee la configuracién del servicio (ancho de banda,
usuatios, parametros de diseminacion, etc.) al proveedor del enlace ascendente (uplink) de DVB. La gestion de la
capacidad del transpondedor de banda ancha por satélite a disposicion de EUMETCast es lograda con canales y a
través del uso de un esquema de prioridades.

El software de gestion multidifusion DVB adapta el enlace ascendente de acuerdo a las prioridades relativas de los
datos que esperan ser transmitido en un canal patticular.

La intetfaz de EUMETCast estd basada en un concepto denominado “Directorios de Servicio”, puntos de entrada
hacia los cuales se transfieren los datos que seran multi-difundidos. Para organizar el flujo, cada directorio de setvicio
se asocia con una lista de distribucién, que identifica a todos los usuatios EUMETCast con derecho a recibir los
datos transferidos al directorio. La estructura de los directorios de servicio también se utiliza para asignar las

caracteristicas de ancho de banda a un determinado conjunto de productos o directorios.

1.3.2.4. Satélites de Telecomunicacion

Los satélites utilizados por los proveedores de enlace ascendente para transmitir la multidifusion de datos originados
en EUMETCast forman parte de la flota de satélites de Eutelsat y New Skies:

e  EUROBIRD™ 9 (localizado a los 9° Este) provee 20 transpondedores en pleno funcionamiento en banda
Ku, que suministran una cobertura en toda Europa, Norte de Africa y Otiente Medio. Bajo el régimen
actual con el proveedor de enlace ascendente, EUMETCast estd disponible a través de uno de los
transpondedores de banda Ku;

e ATLANTIC BIRD™ 3 (localizado a los 5° Oeste) lleva 45 transpondedores en las bandas Ku y C (35
banda-Ku, 10 banda-C) con cobertura en Europa, Africa y Asia occidental. Bajo el régimen actual con el
proveedor del servicio de retransmisién (turnaround) en Africa, EUMETCast esta disponible en uno de los
transpondedores de banda-C;

e NSS-806 (localizado a los 40.5° Oeste) provee una vision éptima de América del Sur, incluyendo la
Peninsula Ibérica, las Islas Canarias, Europa Occidental y gran parte de Europa del Este. Proporciona
cobertura simultdnea tanto de Europa como de América, con una cobertura casi completa del Norte,
Centro y Sur América. EUMETCast esta disponible a través de uno de los transpondedores de banda-C

Los acuerdos con los proveedores de satélites y turnaround se renuevan a través de un procedimiento de
contratacion fija, que puede causar cambios en el satélite que se utiliza. Sin embargo, esto no es frecuente, ya que los

acuerdos se suelen realizar por varios afios.

1.3.25. Alta fiabilidad a través de una red de supervision

Para monitorear el estado del sistema se utilizan estaciones de recepcion de referencia. En cada proveedor de datos
hay estaciones de referencia, asi como también en el proveedor de setvicios de enlace ascendente y en cada
proveedor de servicio de retransmisiéon. Cada proveedor de datos es responsable del monitoreo de extremo a
extremo de sus propios datos. EUMETSAT supervisa el servicio de extremo a extremo en relacién con los datos

proporcionados por EUMETSAT.

1.3.2.6. Estacion de usuario EUMETCast

Una estacién de recepcion puede potencialmente recibitr todo los datos que son transmitidos desde uno de los

satélites de telecomunicacién, independientemente del o los proveedore(s) de datos.

1.3.2.7. Componentes de la Estacion de Recepcion

Basado en pruebas sustanciales de EUMETSAT y en experiencias de usuarios, una estacién de recepcion

EUMETCast tipica comprende:
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e una PC estandar con tatjeta interna de DVB o un DVB router conectado (p. ¢j. a través de USB)
e una antena satelital con foco primario o desplazado, equipada con:
0 un V/H LNB universal digital para banda-Ku (EUMETCast-Europa),
O un cabezal con polatizacién circular, o un filtro de paso de banda (en areas con interferencia de
radar) y un LNB para banda-C (EUMETCast-Africa 0 —Américas).
e El Software de Cliente EUMETCast y, en la mayorfa de las situaciones, la Unidad Llave EUMETCast
(EKU) son necesarias para decodificar y descifrar la sefial de DVB.

Es recomendable establecer dos PCs — una para la recepcion de la sefial de DVB (y/o FTP/servidor web) y otra para
el procesamiento de datos. Dado que los picos de uso del disco rigido pueden interrumpir la recepcién de datos por
DVB, se recomienda que no se procesen o visualicen los datos en la PC dedicada a la recepcién, ni siquiera la

descompresion de archivos. La segunda PC puede encargarse de esas tareas.

Los requerimientos minimos de la PC receptora son: Pentium™ IV 2.0 GHz; 1Gb RAM, 36Gb disco rigido (o mas,
dependiendo de la capacidad de almacenamiento requerida en esa PC); Puerto USB para la EKU; 5 volt PCI bus
(compatible con las tatjetas DVB PCI recomendadas); 100/10 tarjeta de Ethernet (si es necesaria). Microsoft Internet
Explorer (explorador de internet) versién 5.5 o posterior, o Mozilla, o similar, incluyendo JAVA RTE, (requerido
para mostrar la informacién de monitoreo de conexién de TELLICAST).

Ademas, EUMETSAT provee una gufa paso a paso con toda la descripcion técnica para la conexion: EUMET Cast
Technical Description (EUM TD 15, 2004 and 2010). En este documento se va actualizando la informacion sobre las

nuevas placas de DVB, PCs y configuraciones testeadas.

El costo de las estaciones de recepcion de EUMETCast se mantiene al minimo mediante la utilizacién de estindares
industriales abiertos en la medida de lo posible, lo que permite el uso de plataformas y equipos normalmente
disponibles en el 4mbito de televisién por satélite y/o proveedores de Internet por satélite. Ademas de los equipos
anteriores se requiere el Software de Cliente EUMETCast y la EKU, en general se requiere software para el
procesamiento/visualizacién de los datos en funcion de la aplicaciéon real y las necesidades del usuatio, lo que
representa una solucién flexible. A menos que el usuario ya tenga el software de procesamiento adecuado,
DevCoCast recomienda el uso de software libre, como ILWIS y GEONETCast Toolbox (ver seccion 1.5).

1.3.2.8. Unidad Llave (EKU) y Software de Cliente EUMETCast

EUMETSAT provee el Software de Cliente EUMETCast (EUMETCast Client Software, TELLICAST) y la Unidad
Llave EUMETCast (EUMETCast Key Unit, EKU) necesaria para descifrar la sefial de DVB. Estos son entregados
conjuntamente como un dispositivo USB y un CDROM, que forman parte del Paquete EUMETCast (EUMETCast
Package). El EUMETCast Package esta disponible para todos los usuarios registrados e incluye:

e  Laultima version de EUMETCast Client Software (TELLICAST);

e EKU Run-Time-Environment, disponible pata los sistemas MS Windows y Linux;

e Una seleccién de Drivers para las distintas tarjetas DVB recomendadas;

e Documentacion, notas para solucionar problemas, archivos readme, Tellicast license notes, etc.

El EUMETCast Client Software disponible para los sistemas MS Windows y Linux se encarga de realizar los
siguientes procesos:
e Descifrado de los datos basados en una clave;

e La correccion de errores y la gestion de los archivos recibidos.

Como en la actualidad EUMETCast opera un servidor TELLICAST, el TELLICAST software es obligatorio. Por
cada PC en la que se instala el software, se debe pagar una licencia. Una tarifa dnica por licencia estd incluida en el
precio del CD-ROM con el software (en la actualidad 60 Euros). La instalacion del software puede realizarse y

cuando se solicita el nombre de usuario y contrasefia deben ingresarse los proporcionados por EUMETSAT.
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Figura 1.5 Tellicast Client Software
La EUMETCast Key Unit (EKU) es un dispositivo USB usado en conjunto con el EUMETCast Client Software
para proveer una recepcion de servicios que requieren licencias diferentes y/o accesos restringidos. El costo actual de
una EKU es 40 euros. EUMETSAT es el tnico proveedor de EKUs e incluye en el envio del paquete el EKU Run-

Time-Environment software, tanto para sistemas MS Windows como Linux.

Figura 1.6 EUMETSAT Key Unit

1.3.2.9. Tamafio de la antena, ubicacion y parametros del satélite
El tamafio de la antena depende del lugar donde esta instalada la estacién receptora y de la banda de frecuencia (Ku,
C) utilizada. En la tabla 1.2 se proporciona mas informacién, seguida por las huellas de los satélites y sus parimetros

de recepcion. Para apuntar la antena puede ser de utilidad la dish pointing utility disponible en

http://www.dishpointer.com/. Sitios como http://www.satsig.net/africa/vsat-installers-africahtm y EUMETSAT

manufacturer list pueden asistir en la localizacién de profesionales para la instalacion.

Banda Localizacion Tamano de la Antena

Europa (banda-Ku) | dentro del "nucleo" de la huella geogrifica del satélite, el | 120cm o menos (uso no
area delimitada por el contorno dBW 50 del ™ | profesional 85 cm)
EUROBIRD 9. Huella, ver la figura 1.7

Europa (banda-Ku) | dentro de la zona "extendida" de cobertura geogrifica | 1.8m o mas
(Islas remotas de Europa, Este de Turkia y paises de
Europa del Este)

Africa (banda-C) dentro del "nucleo" de la huella geografica, el drea | 2.4m o mis
delimitada por el contorno interno de la huella del
Atlantic™ Bird 3, ver figura 1.8

Africa (banda-C) dentro de la zona "extendida" de cobertura geogrifica | 3.7m o mis

(Madagascar, La Reunion, partes de Norte América)

Sudamérica dentro del area comprendida por el contorno de 39 dBW | 2.4m o mas
(banda-C) de la huella geografica del NSS806 , ver figura 1.9

Sudamérica antenas mas pequefias pueden ser suficientes dependiendo | 1.8m o mas
(banda-C) de la ubicacién, para mas informacién contactarse con

EUMETSAT (ops@ecumetsat.int)

Tabla 1.2 Dimension de las antenas para distintas regiones

10
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Transpondedor banda-Ku EUROBIRD™ 9

Parametros Valor

Nombre EUROBIRD™ 9
Transpondedor TP63

Down Link Frequency 11976.82 MHz
Symbol Rate 27500 kS/s

FEC 3/4

Polarizacion Horizontal

Transpondedor de banda- CAtlantic Bird™

Parimetros

Atlantic Bird™ 3

Valor

Nombre

Transpondedor C02

Down Link Frequency 3731.7570 MHz
Symbol Rate 11.963 MS/s
FEC 2/3

Polarizacion Circular izquierda

C-band downlink co
ATLANTIC BIRD™ 3 at 5° West

lor

] Nombre NSS806
Transpondedor 22A
Down Link Frequency 3.803 GHz
Symbol Rate 27.500 MS/s
f FEC 3/4
Polarizacion Circular izquierda

i

Figura 1.9 Cobertura del satélite NSS-806 y caracteristicas del transponedor

Estos graficos asumen que las antenas estin correctamente apuntadas, el LBN y los equipos de recepcion son de
ultima generacién y que los cables no son demasiado largos ni tienen pérdida sustancial de la sefial. Las antenas

pequefias (p. ¢j.: usadas en la recepcién de TV) en general proveen de una buena recepcion durante condiciones

11
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meteorologicas Optimas, pero tienen pérdidas en condiciones de lluvia o nieve. Para las antenas de 60 cm,
ampliamente usadas, se deben substraer 2.5 dB del margen de enlace de las antenas de 80 cm, y chequear si asi

continian proveyendo un margen positivo.

1.3.3. Configuraciéon de EUMETCast para el flujo de datos de DevCoCast

Normalmente, los archivos de proveedores de datos como los de DevCoCast son transferidos via FTP/INTERNET
al EUMETSAT Operations Internet Server (OIS), un servidor de FTP localizado en EUMETSAT en Darmstadt,
Alemania. EUMETSAT luego procesa y/o transfiere los productos a su sitio de enlace ascendente en Usingen
(Alemania), donde son convertidos a un flujo de datos en DVB (Digital Video Broadcast) para la mdltiple
diseminacion via EUMETCast, o via RMDCN/redes de internet para intercambiar datos con otros componentes de
GEONETCast (p. ¢j. Al CMA para el sistema de transmision en China).

En el contexto de DevCoCast, solo los productos de DMI (Dinamarca) son enviados a CMA en China para una
prueba piloto de transmisién. Todos los demas productos son agregados a EUMETCast, en un canal que esta
disponible en todo el espectro de huellas satelitales de EUMETCast (EUMETCast-Europa, EUMETCast-Africa y
EUMETCast-Américas).

Los productos del INPE (Brasil) son diseminados via EUMETCast, como parte del servicio de DevCoCast. Estos
primero se envian via FTP desde INPE a EUMETSAT, donde son convertidos a DVB en el servidor de enlace
ascendente para luego ser diseminados por EUMETCast en la banda-Ku, banda-C Américas (principales usuarios de
estos datos) y banda-C Africa.

Para los restantes ocho proveedores de productos en Africa, Sudamérica y Europa, incluyendo a VITO y PML, las
interfaces de operacién se realizan entre EUMETSAT vy los centros de concentracién y redistribucién (hubs) en
VITO, para productos terrestres, y en el PML, para productos marinos. Estos centros (hubs) son explicados en la

proxima seccion.

E Internet '
ol Eumelsat
,/\ oisftp. eumelsat org
Rl | Internet
S (Backup)
INPE
ocean products  |© s
= i B
PML
land products r/\
African | | |
Product Providers P

Figura 1.10 Esquema de Ia provision y diseminacion de datos en DevCoCast
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1.4. Extendiendo la infraestructura de transmision: los “hubs” de DevCoCast

Los sistemas hub, tanto terrestres como marinos, son nodos intermediarios de concentracién de datos, encargados
del control de la diseminacién de imégenes satelitales e informacién derivada. Si bien fueron disefiados y
desarrollados dentro de DevCoCast, se hayan muy bien integrados con el resto de la infraestructura de
GEONETCast (en particular EUMETCast), actuando como agregados opcionales de EUMETSAT como el
principal GEONETCast Networking Centre. Por lo tanto, pueden ser ficilmente re-utilizados y extendidos para

manejar el flujo de productos adicionales.

Los sistemas hub de DevCoCast ayudan a colectar el diverso flujo productos temdticos terrestres y marinos,
incluyendo algunos originados en Africa y Sudamérica. Los hubs luego envian los productos a EUMETSAT para el
sistema de transmision de EUMETCast, siendo programados en funcién de las prioridades y ancho de banda
disponible. Los propdsitos principales de los hubs son:
e  Canalizar los productos terrestres y marinos y simplificar su transporte desde los productores hasta el
sistema de diseminacion que opera EUMETSAT;
e Extender la red de GEONETCast con proveedores y productos adicionales, cubriendo una mayor cantidad
de temas de aplicaciéon (més alla de la meteorologia) que son relevantes con respecto a las Areas de
Beneficios Sociales GEO.

De esta manera, los proveedores cuentan con un solo punto de contacto, en el hub, el cual posee conocimiento
especifico sobre los productos de su dominio de aplicacion, asf como amplia experiencia interactuando con el centro
de operaciones de EUMETSAT GNC. El contacto en el hub puede asistir a los proveedotes respecto a ajustes de
formato de los productos, monitoreo del flujo de informacién y otras consultas.

Desde la perspectiva de EUMETSAT, en vez de tener muchas interfaces con distintos proveedores, en cada uno de
los hubs tienen un solo punto de contacto de DevCoCast, con conocimiento especifico de los productos, sus
frecuencias y los propios procedimientos de EUMETSAT.

Desde el propio punto de vista del hub, ellos pueden asegurar un control apropiado del flujo de datos de DevCoCast
a través de un sistema simple pero robusto, con monitoreo, priorizacion, y mecanismos de reduccion de fallas
rutinarios. De hecho, los hubs estin disefiados para reemplazarse mutuamente en caso de que uno presente un fallo
total. Si bien esto no ocurre con frecuencia, los hubs tienen la misma configuracién y pueden ser vistos como copias
especulates, siendo VITO el que normalmente se encarga de los productos terrestres y raramente los marinos, a la
inversa de PML.

13
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Figura 1.11 Esquema de los proveedores de datos de DevCoCast, hubs y la transmision de EUMETCAST

14.1.

Caracteristicas de los hubs

El propésito principal del hub de DevCoCast es recolectar datos de multiples proveedores y enviarlos a

EUMETSAT de una manera controlada y efectiva. Las principales caracteristicas de los hubs son las siguientes:

Control del ancho de banda: en total, por proveedor y por prioridad del producto

L]
e  Priorizacion
e Alta resiliencia
0 Redundancia (los hubs se respaldan el uno al otro)
0 Prevencién de retransmision
e Monitoreo extensivo
0  Registro detallado de transmision
0 Integracién con Nagios (un sistema de c6digo abierto para monitoreo de computadoras y redes)
0  Graficos de transmision a través de secuencias de comandos (scripts) externos
e Sistema flexible y extensible
0 Seleccion de destino por producto, permitiendo que puedan ser enviados a sistemas alternativos
durante fases de prueba.
0 Posibilidad de multiples hubs en un mismo servidor
0 Disparador de procesos genéricos, permitiendo el proceso personalizado de productos
individuales (p. ¢j. compresién adiciona o, estandarizacién del nombre del archivo.)
1411 Control del ancho de banda

Una funcién clave del hub es limitar la cantidad de datos transmitidos en un momento dado. Esto es vital, ya que el
proyecto DevCoCast tiene un cierto ancho de banda disponible a través de EUMETCast que no puede set excedido.

También es importante asegurarse de que los servidores de EUMETSAT no se inunden con grandes volimenes

repentinos de datos, otra funcién de los hubs es esparcir las transmisiones en el tiempo.

El primer objetivo se logra mediante la creaciéon, manejo y mantenimiento de restricciones (potencialmente por

proveedor, por tipo de producto y por nivel de prioridad). El segundo objetivo, lograr un flujo mas parejo de datos,

14
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se logra mediante la difusién de ancho de banda disponible de forma lineal a lo largo de perfodos de tiempo (por lo
general 3 horas o 1 dfa) y la acumulacién en un fondo comun de tal manera que un producto solo es transmitido

cuando se haya acumulado suficiente ancho de banda no utilizado.
Los Hubs también llevan a cabo algunas pruebas en nombres de archivos y contenido de los datos (checksum) para

asegurar que los archivos de datos no sean transmitidos varias veces debido a errores en los sistemas de un

proveedor de datos o en el hub mismo.

1.4.1.2. Priorizacion

No todos los datos que viajan a través del hub son igualmente urgentes. Los productos con la alta temporalidad (por
ejemplo imagenes de eventos, como las que cubren un incendio), deben ser transmitidos con mas urgencia que los
productos de resumen mensual o semanal. Otra funcién del hub es asegurar que los datos de mayor prioridad sean

enviados primero. Hay cinco niveles de prioridad diferentes:

e Muy baja (p. ¢j. datos con frecuencias menores a mensual)
e  Baja (p. ¢j. resimenes mensuales)
e Media (p. ¢j. productos semanales)
e  Alta (p. ¢j. productos ocednicos en casi tiempo teal / productos terrestres diarios)
e Muy alta (p. ¢j. imagenes de eventos, como productos de incendios en tiempo casi real)
Estos niveles de prioridad son asignados dependiendo de los objetivos del proyecto y de las catractetisticas de los

datos.

14.13. Integracion completa

Como se describié anteriormente, los hubs se integran en el sistema principal de GEONETCast. Los operadores de
los hubs (PML y VITO) garantizan que los procedimientos relevantes de EUMETSAT se llevan a cabo, asistiendo a
los proveedores de productos de EO para que el cumplimiento de los requisitos operacionales de difusion
(metadatos, pruebas de transmisién, anuncios de usuario, etc.) sea logrado mas facil y flexiblemente. Asimismo los
operadores de los hubs asisten a EUMETSAT en el manejo de un nimero creciente de proveedores de productos,

particularmente de las areas tematicas en que EUMETSAT esta menos familiarizado.

1.4.1.4. Redundancia

En el caso de un problema (mantenimiento programado o cortes no programado), cada hub puede funcionar como
una copia de seguridad del otro. Por lo tanto, si el hub en el PML se ve afectado por un corte local, entonces los
proveedores de datos marinos pueden (potencialmente de manera automatica) transmitir hacia el hub de VITO.
Dado que ambos hubs tienen la misma configuracion, el corte y el cambio puede ser transparente para el proveedor
de datos, EUMETSAT vy los usuarios finales. Los hubs comparten informacién sobre los productos transmitidos,
cada 15 minutos y de forma rutinaria, por lo que las retransmisiones son poco probables y se limitan a una pequefia

ventana temporal.

1.4.15. Operaciones Basicas de los Hubs

Los proveedores cargan los datos y productos de informacion de EO via FIP en el hub correspondiente,
nombrando los archivos de acuerdo a un formato predefinido. Una vez que un archivo llega a un hub de DevCoCast,
se lo reconoce por su nombre, se define su prioridad, cambio de formato potencial (cambio de nombre, de
compresion, etc.) y, una vez que se dispone de suficiente ancho de banda y todas las restricciones fueron superadas,
es transmitido a EUMETSAT.

Los archivos se priorizan principalmente de acuerdo a la sensibilidad al tiempo de los datos. Dentro de un intervalo
establecido (= 5 minutos), el hub intenta enviar todos los archivos en orden de prioridad, comenzando con los de

mas alta prioridad. El hub también administra la reserva de ancho de banda para productos de alta prioridad, y la
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redistribucién gradual del ancho de banda no utilizado por productos de mayor o menor prioridad en un periodo
dado.

Distintas cantidades de ancho de banda pueden reservarse para cada prioridad, permitiendo ajustar la cantidad de
datos de cada prioridad que serd enviada en un momento dado. Los hubs también pueden configurar
diferencialmente el ancho de banda por proveedor de manera de asegurar que ninguno monopolice el ancho de
banda de DevCoCast.

Algunos archivos pueden requerir tratamiento adicional o estandarizacién. Esto puede realizarse en el hub de manera
sencilla, siendo posible ejecutar un proceso arbitratio en cualquier atrchivo que llega. Todo lo que se necesita en el

hub es una copia de comandos compatibles con Linux/archivo ejecutable.

Las operaciéon de un hub es simple pero robusta, en el diagrama de flujo de la figura 1.12 puede observarse una

detallada descripcion de las rutinas implementadas.

Scan incoming directory
for files matching
filename patterns

A 4

Move new files to queuing
directory

A

For each file in
queuing directory

Has file already
been sent?

Remove file

Do any extra processing
required on file

Has transmission quantity
gone over constraints?

send file to designated
ftp location

o J

Figura 1.12 Descripcion de las operaciones de un hub

Una vez que se ha determinado la asignacién de ancho de banda a un archivo, este es transmitido a EUMETSAT via
FTP. EUMETSAT tiene varios directorios de servicios, cada uno para un uso especifico. Esto no es evidente para el
usuatio final, ya que EUMETSAT agrupa los datos en canales para su difusion.
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1.4.16. Monitoreo de los hubs

Los hubs proveen un registro detallado de los productos transmitidos y las acciones realizadas. Esto permite una
realizar una depuracién detallada o el rastreo de un producto a través del sistema. Estos registros también se resumen
en graficos que muestran las tasas globales de flujo, para un mejor monitoreo del sistema DevCoCast (véase la
Figura 1.13 para un ejemplo).

Por ultimo, existen comandos para integrar los hubs con Nagios, una soluciéon de cédigo abierto para monitoreo, de
manera tal que se pueden enviar alertas a los operadores cuando se detecta un problema (como la pérdida de
conectividad del hub con la red) o problemas potenciales (p. ¢j. un nimero inesperadamente bajo de productos de un

determinado proveedor).

Graph to show the rolling sum over 3 hours of amount transmissions from the PML DevCoCast hub - 2011-08-12 12:40:16
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Figura 1.13 Grafico de transmision del hub PML de DevCoCast a lo largo de varios dias.

1.5. Software libre y de cddigo abierto
Para facilitar la utilizacion de GEONETCast y el uso de datos compartidos, el equipo de DevCoCast desarrolla y

promueve (en foros, conferencias, etc.) el uso de software libre y/o de codigo abierto para el procesamiento y la
visualizacién de los datos diseminados. Esto incluye softwate especifico de los proveedores como el “VGTExtract”
de VITO (disponible en: http://www.devcocast.eu) pata la integracion de SPOT-VEGETATION con los software

de SIG que puedan utilizar normalmente los usuarios. Ademas, se ha desarrollado un grupo de herramientas

(GEONETCast toolbox) que funciona como un agregado de la versiéon libre de “ILWIS” (disponible en:

http://www.52north.org/communities/earth-observation). Este software puede importar y administrar una amplia
variedad de datos diseminados por GEONETCast y al mismo tiempo exportarlos a un SIG (ILWIS, disponible en:

http://www.52north.org/communities/ilwis). Por esta razén ha sido ampliamente utilizado y mejorado para

DevCoCast y actividades de formacion relacionadas (talleres, desarrollo material didactico).

El equipo de DevCoCast mantiene una postura abierta y apoya a los usuarios que desean utilizar el software que
normalmente utilizan mientras puedan cumplir con sus objetivos. Datos recientes muestran que hay un aumento en
el uso de software libre por parte de usuarios claves, como los Servicios Nacionales Meteorolégicos Africanos
(UFA9 Report, 2010).
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151 Software para la Gestion de Datos

Una instalada y configurada una estacion receptora, los datos y productos ambientales que se (re) transmiten a través
de los satélites de comunicacién pueden ser recibidos y almacenados en un dispositivo de almacenamiento. Dado que
a través de GEONETCast se reciben datos continuamente (24 horas al dia, 7 dias a la semana), se ha desarrollado el
“GEONETCast Data Manager", un sistema de gestién de datos desatrollado pata administrar automaticamente el
flujo de informacién. Esta utilidad se puede configurar facilmente utilizando simple archivo de texto ASCIIL. Para
actualizar el archivo de configuracién y adaptarse a los cambios en el flujo de datos no es necesario tener experiencia

en programacién. El “GEONETCast Data Managetr" puede utilizarse de manera independiente y puede ser

descargado de: http://52north.org/communities/earth-observation/data-manager-software.

15.2. ILWIS Open

ILWIS OPEN 3.7 (o la versiéon mas reciente) integra herramientas para manejar imagenes, vectores y datos tematicos
en un poderoso paquete de escritorio. Este incluye una amplia gama de herramientas para importacién/exportacion,
digitalizacién, edicién, analisis y visualizaciéon de datos, asi como la produccion de mapas de alta calidad. Sus
caracterfsticas principales son:

e Disefio raster y vectotial integrado

e Importacién y exportacion de archivos a los formatos de datos mas utilizados

e Digitalizaciéon en pantalla y tableta

e Amplio grupo de herramientas para el procesamiento de imagenes

e Orthophoto, geo-referenciacion, transformacioén y produccién de mosaicos de imdgenes

e Modelacion y analisis espacial avanzado de datos

e Visualizador 3D con herramientas para la edicion interactiva

e Amplia biblioteca de sistemas de coordenadas y proyecciones

e Anilisis geoestadistico, con Kriging para mejorar las interpolaciones

e Produccion y visualizacién de pares de imagenes estereo

e Evaluacién especial multicriterio

e Servicio de Mapeo en la Web

e Balances de energfa superficial
ILWIS puede ser wusado como wun programa independiente y se lo puede descargar de:

http://52north.org/communities/ilwis/ download. donde también se puede encontrar material educativo adicional.

Los usuarios de Sudamérica pueden consultar la siguiente pagina para mas informacién: http://www.ilwis.org

153. GEONETCast Toolbox Software
El GEONETCast Toolbox es un agregado de ILWIS 3.7 Open (o la versién mas reciente). Este permite un facil

acceso y manejo de los datos de GEONETCast (datos y productos provenientes de varios satélites) y es un excelente
soporte para el subsecuente procesamiento geoespacial de la informacién con ILWIS 3.7 Open u otros SIG. El
GEONETCast_Toolbox_ZIP puede wusarse como un agregado de ILWIS y descargarse de:
http://52north.org/downloads/earth-observation/ GEONETCast/toolbox. Ah{ también encontraran Guias para la

instalacion, configuraciéon y manejo del software, incluyendo ejercicios basados en varios ejemplos de datos y

productos diseminados via GEONETCast. En las paginas del ITC-GEONETCast
(http://www.itc.nl/Pub/WRS/WRS-GEONETCast) puede encontrarse mas informacion.

1.6. Alcance del presente manual

Dado que el sistema para compartir datos de Observacion Terrestre ya ha sido establecido, el proyecto se enfoca
ahora al uso y la adicién de valor agregado de los productos compartidos. En éste capitulo del manual se introdujo
brevemente el sistema de transmision de EUMETCast, como también los hubs de DevCoCast hub, la estructura de

recepcion satelital y el uso de software de cddigo abierto y gratuito. Para obtener mas informacion sobre los mismos
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se pueden consultar varios documentos en distintas paginas web cuyos links se encuentran en la seccién de
Referencias.

Los proximos capitulos del presente manual describen diversas aplicaciones usando datos de GEONETCast, en
conjunto con informacién local de Africa y América Tatina. Los cjemplos de aplicaciones presentados fueron
desarrollados en colaboracién con grupos de expertos locales durante (entre otros) un curso de entrenamiento
avanzado de DevCoCast de dos semanas y demuestran el potencial uso de la informacién diseminada para el manejo
y monitoreo del ambiente.

Las aplicaciones descritas se basan en ejemplos del mundo real y pueden ser usadas como casos de estudio y
ejercicios independientes que demuestran el valor agregado de GEONETCast para la evaluaciéon ambiental. Todos
los ejercicios se basan en ILWIS Open, version 3.7.2, la cual estd disponible gratuitamente. Los datos de ejemplo

para los ejercicios pueden obtenerse en DVD y descargarse de (http://www.itc.nl/Pub/WRS/WRS-

GEONETCast/Application-manual.html y http://www. devcocast.eu/). Los comentatios, opiniones y/o ejetcicios

adicionales de usuarios son muy valorados y pueden enviarse al ITC via la Comunidad de Observacion Terrestre en

52North.org (http://52north.org/communities/earth-observation /community-contact).
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Apéndice 1 Productos del Hub Terrestre en VITO y Marino en PML

Productos del hub terrestre para la diseminacién a través de EUMET Cast.

Tiempo
Nombre Tamafio de
) X For- i Frecue
Producto | Completo del Nombre del Archivo OIS In Nombre del Archivo EXGate Out compri . Genera
mato ncia
Producto mido cién
(UTC)
VITO
Indice Dias 1
fas
Diferencial de Achi 11 21, 1S
., V2KRNS10__YYYYMMDD_NDVI__ | V2KRNS10_YYYYMMDD_NDVI__ - y .
NDVI Vegetacion . . ’ . . A vo ~25Mb ¥ dias
. S-America.ZIP S-America.ZIP K de cada
Normalizado Zip después
L. mes
- Sudamérica
Indice .
. . i Dias 1,
Diferencial de AR NDWI YY DDO0 AR ND DD00 Archi 11y21 s
] ¢2_BIOPAR_NDWI_YYYYMMDDO00 | g2 BIOPAR_NDWI_YYYYMMDDO! y )
7 ~20 M
NDWI Agua 00_S-America_VGT_V0.2.zip 00_S-America_VGT_V0.2.zip ve 20Mb | ada | 428 )
Normalizado Zip después
. mes
- Sudamérica
Productividad . Dias 1,
M i 2_BIOPAR_DMP_YYYYMMDDO000 2_BIOPAR_DMP_YYYYMMDDO000 Archi 11y21 ~s
e Materia / / / M y
DMP i e B vo | ~35Mb |- Y7 | dias
Seca- 0_S-America_VGT_V0.1.zip 0_S-America_VGT_VO0.1.zip K de cada ,
» Zip después
Sudamérica mes
Dias 1,
Productos de MCD_GreenAs YYYYMMDD MCD_G: A YYYYMMDD Archi 11y21 -5
1 MM Eri il IM Eri y
LOC la Langosta —reenfirent : [t —reenreat) [Frit VO ~1-4Mb y dias
K rea | Mali | N-Sudan].zip rea | Mali | N-Sudan].zip K de cada
del Desierto Zip después
mes
CSIR
Indice de
Peligro de ASCI
FFDI Incendios CSIR_FFDIL_YYYYMMDD1200.txt CSIR_FFDIL_YYYYMMDD1200.txt I 242Kb Daily 12:00
Forestales de
MacArthur
Indice de
Peligro de ASCI .
LFDI ] CSIR_LEDL YYYYMMDD1200.txt CSIR_FFDLYYYYMMDD1200.txt 242Kb | Daily 12:00
Incendios de 1 ’
Lowveld
INTA
Mapa de
Anomalias .
del indi Diasl. 15
el Indice \ ; i J e i A ~1-
ANOMN ' ' INTA_HRPT_V eg.etatlon_lndex_z\nom INTA_HRPT_V eg{etaunnflmdefonom . ~240 11y21 ]
DVI Diferencial de | aly_YYYYMM-K gif aly_YYYYMM-K.gif Gif Kb 4 . d dias
. K| e cada
Vegetacion [K = Dekad = 1,2,3] [K = Dekad = 1,2,3] después
mes
Normalizado
- Sudamérica
Indice de Dias 1,
. INTA_NOAA_AVHRR_18_19_Fire_ R | INTA_NOAA_AVHRR_18_19_Fire R ~1-5
Peligro de . X . R . ~ 300 11y21 3
FDI I di isk_ YYYYMM-K.gif isk_ YYYYMM-K.gif Gif Kb q ° q dias
neendios = | g = Dekad = 1,2,3] K = Dekad = 1,2,3] © A despues
Sudamérica mes
Mapa del
Indice Dias 1, 15
J 7o : e J Teoetati " ~1-
Diferencial de INTA?HRPT?? egetation_Index_ INTA?HRPT?I\ egetation_Index_ . ~260 11 . 21 ]
NDVIM V. ., YYYYMM-K.gif YYYYMM-K.gif Gif Kb d q dias
cgetacion K = Dekad = 1,2,3] K = Dekad = 1,2,3] AR despues
Normalizado mes
- Sudamérica
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. Dias 1,
Evapotranspi | INTA_NOAA_AVHRR_Evapotranspir | INTA_NOAA_AVHRR_Evapotranspir ~500 11y21 ~1-5
ETR racién Real - | ation_ YYYYMM-K.gif ation_ YYYYMM-K gif Gif Kb q ° q dias
Sudamérica | K = Dekad = 1.2,3] K = Dekad = 1,2,3] €A después
mes
Productos marinos para la diseminacion a través de EUMETCast.
N Tiempo
Tamaf q
e
Nombre . . Form | o Frecue X
Producto Nombre del archivo OIS In Nombre del archivo EXGate Out X i Generaci
Completo ato compri | ncia ,
6n
mido
(UTC)
PML
PML_<pml > _MODIS_ss YY
Porducto —~pm_area> ] -SSR | PMIL_<pmi_area> MODIS_sst_nrt_YY
L. YMMDDHHMMSS.nc.bz2 N
Ocednico en YMMDDHHMMSS.nc.bz2 NetC . 24 por X
PMLAFR . . PML_<pml_area>_MERIS_oc_ntt_YY PML <oml > MERIS YY | DEv3 Bzip2 di Varios
Hempo Cast | v\ IMDDHHMMSS.nc.bz2 ihopm_area— —ocnrt- V- 1a
real = Affica | (o YMMDDHHMMSS.nc.bz2
see
Porducto
PMLBRA chénico én PML_Brazil MERIS_oc_nrt_<passtime | PML_Brazil MERIS_oc_nrt_<passtime NefC Brip2 1,p0r Varios
tiempo casi >.nc.bz2 >.nc.bz2 DFv3 dia
real — Brasil
. PMIL_<pml_area>_MODIS_sst_refined | PML_<pml_area>_MODIS_sst_refined
Productos o2 o2 NetC 1
L. _<passtime>.nc.bz! _<passtime>.nc.bz! et ) por
TBC Ocednicos PMIL_<pml_area>_MERIS_oc_refined_ | PML_<pml_area>_MERIS_oc_refined_ | DFv3 BleZ dia TBC
refinados <passtime>.nc.bz2 <passtime>.nc.bz2
UcCT
JICT_< >_MODIS_chl YY
UCT_<uct_atea>_MODIS_chlora_YYY | Lo~ uct-area> MODIS_chlora_
YYMMDD.nc.bz2
YMMDD nebz2 UCT_<uct_area>_MODIS_Kd490_Y
1 10
Producto UCT_<uct_area> MODIS_Kd490_YY q—mL;CD—Da e o - 40- 1 por
AQUA:O o YYMMDD.nc.bz2 Y Y YMAMDD.ne bz i | NetC | 2000K | diay i
Oceanico de ) UCT_<uct_area>_MODIS_nflh_YYY Varios
CPUCT UCT_<uct_area>_MODIS_nflh_YYYY DFv3 b por
Nivel 3 YMMDD.nc.bz2
MMDD.nc.bz2 UCT < > MODIS sst Y bzip2 area
UCT_<uct_area> MODIS_sst_YYYY —Suerarez —SSEXY
MMDD.nc.bz2
MMDD.nc.bz2
UCT_<uct_area>_MERIS_algall_YYY UCT_<uct_area>_MERIS_algall_YY
YMMDD.nc.bz2 YYMMDD.nc.bz2
ENVISA | Producto ;Ji:;h;lL;cLa]r:aZ>J\1ER157algalszw ggﬁ;;;farez>27MERlsfalga127YY e ‘2‘8(*)0K cli’POf
. ‘MM .nc. .nc.| et {a y R
T:OCPU | Oceénico de . febz nebz ’ Varios
X UCT_<uct_area>_MERIS_totalsusp_Y UCT_<uct_area>_MERIS_totalsusp_ DFv3 b por
cr Nivel 3 YYYMMDD.nc.bz2 YYYYMMDD.nc.bz2 brip2 | drea
UCT_<uct_area>_MERIS_yellowsubs_ UCT_<uct_area>_MERIS_yellowsubs
YYYYMMDD.nc.bz2 _YYYYMMDD.nc.bz2
JRC
Producto TBD, but currently Luego
. ° . 5-7MB | Mensu
JRC Oceanicode | AYYYYJJJYYYY]JJJ_<product>_A | TBD Ascii bain2 ) del fin
. 7 a
Nivel 4 MIS.nc.bz2 p de mes

<PML_area>=Algeria, Egypt, EMadagascar, Ghana, Libya, Mozambique, NEMadagascar, NMorocco, RedSea,

Sierral.eone, or SMorocco

<UCT_area>= Angola, Cotedlvoire, ESAfrica, Guinea, Mauritania, MChannel, Namibia, Nigeria,
NSomalia, Senegal, SSAfrica, SSomalia, Tanzania, or WSAfrica
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Capitulo 7. Desarrollo de una herramienta para monitor el
crecimiento y rendimiento de cultivos

Antonio de la Casal! y Gustavo Ovando?

El Centro de Relevamiento y Evaluacién de Recursos Agricolas y Naturales (CREAN) es una unidad de
investigacion aplicada de la Facultad de Ciencias Agricolas de la Universidad Nacional de Cérdoba (Argentina). El
objetivo general de CREAN es contribuir al desarrollo de estrategias para la gestién sostenible de los recursos
naturales y agricolas, basadas en el uso racional de la conservacién y recuperacién del patrimonio ambiental. Este
consiste en la elaboracién de programas de aplicacién utilizando la informacién de teledeteccion y de los sistemas de
informacion geografica. CREAN desempefia un papel activo para desarrollar nuevas metodologias destinadas a
evaluar los procesos de desertificacion, la productividad y rendimiento de cultivos y su disttibucion geografica.
Ademis, el centro ofrece apoyo tecnoldgico a los sectores publico y privado sobtre los usos y aplicaciones de

informacién meteoroldgica y los recursos naturales.

1.1 Importancia del tema seleccionado

El monitoreo de los cultivos agricolas a lo largo de la temporada de crecimiento puede proporcionar informacion
para hacer predicciones de rendimiento antes de la cosecha. Esto es importante para la toma de decisiones a
diferentes niveles, tanto para la logistica como para las actividades de comercializacion (Rizzi y Rudorff 2005).

El rendimiento de un cultivo estd determinado por sus caracteristicas genéticas y las condiciones que prevalecen
durante el perfodo de crecimiento, tales como las condiciones climaticas y meteorolégicas, fertilidad del suelo,
control de plagas y enfermedades, el estrés hidrico y otros factores que afectan el crecimiento del cultivo. El
rendimiento de los cultivos puede variar ostensiblemente en funcién de las condiciones dominantes. El rendimiento
esperado de acuerdo a distintas condiciones de crecimiento se puede estimat por medio de modelos mecanisticos de
crecimiento de cultivos (Boote et al. 1998, Brisson et al, 2003; Yang et al, 2004). Este tipo de modelos no sélo simula
el rendimiento, sino también el desarrollo del cultivo durante todo su ciclo de crecimiento. Los modelos
mecanicistas, sin embargo, requieren generalmente de un conjunto enorme de datos de entrada que a menudo es
dificil de conseguir fuera de los centros de investigacion. Asimismo, como requieren también de una adecuada
calibracion especifica para el sitio de uso antes de poder ser aplicados, este tipo de modelo no suele ser muy util para
el desarrollo de estrategias de riego o cuando se lo aplica para realizar evaluaciones en condiciones practicas.

Para fines de planificacién y evaluacion agricola a partir de datos limitados, existe un enfoque mds general y sencillo.
La modelo funcional presentado por Doorenbos y Kassam (1979), que desctibe la relacion entre el estrés hidrico y el
la pérdida de productividad correspondiente es de gran utilidad:

Ya ETa
1-—2% Ky |1-—2 Eq. 1
Y max ET max
Donde Ya/Ymax es el rendimiento relativo; (1-Ya/Ymax) la disminucién del rendimiento relativo, ETa/ETmax la
evapotranspiracion relativa, y (1-ETa/ETmax) es la falta de agua o déficit de la evapotranspiracion relativa.

La respuesta del rendimiento a la falta de agua en un ambiente determinado, se cuantifica a través del factor de
respuesta del rendimiento (Ky). La relacién entre la disminucién del rendimiento y la falta de agua es lineal, siempre y
cuando la escasez de agua no supere el 50%. En el modelo, el rendimiento real (Ya) se expresa como una fraccién del
rendimiento maximo (Ymax), que se puede alcanzar cuando la disponibilidad de agua no limita el crecimiento. ETa
se refiere a la evapotranspiracion real o actual del cultivo de acuerdo a condiciones de crecimiento, y ETmax es la
evapotranspiraciéon en las mismas condiciones, pero bajo un suministro de agua no limitante.

Este modelo funcional se ha aplicado de diferentes maneras segin el tipo y la disponibilidad de la informacion
utilizada (Rojas, 2007). Raes et al. (2006) emplearon un procedimiento de balance de agua para estimar ETa a partir
de informacién meteoroldgica (ETmax y datos de precipitacion), asi como las caracteristicas del suelo en relacién con
el contenido de agua para calcular la pérdida de rendimiento de los cultivos.

1 Antonio de la Casa email: delacasa@agro.unc.edu.ar
2 Gustavo Ovando email: gugovan(@gmail.com
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La teledeteccién espacial ofrece informacién extendida territorialmente sobre el estado actual de los cultivos, y se ha
utilizado también pata apoyar la parametrizacioén de los modelos de cultivos (Guérif y Duke, 2000). Las ventajas que
ofrece la teledeteccion se han explotado en los dltimos afios para monitorear la vegetacion y evaluar el impacto de la
sequia sobre el rendimiento de los cultivos. Caselles et al. (1993) utilizaron imagenes NDVI de NOAA-AVHRR para
determinar, junto con los datos de campo, los diversos componentes del modelo de productividad de la FAO. Funk
y Budde (2009) presentaron un desglose detallado de los estudios sobre el rendimiento de los cultivos y el NDVI, y
sostienen la conveniencia de ajustar la relacién entre la sequia y la productividad sobre la base de datos fenolégicos.
De la Casa y Ovando (2007) desarrollaron un modelo de cultivo para estimar el rendimiento de maifz a nivel
regional /departamental, integrando datos de NDVI con informacién fenolégica.

Una estrategia conveniente para que los métodos de estimacién de rendimiento resulten mas robustos y facilmente
transferibles es realizar la integracion de los datos de teledeteccién con los modelos de simulacién de cultivos
(Doraiswamy et al., 2003). Motiondo et al. (2007) presentan el desarrollo y prueba de un marco metodolégico que
utiliza datos de NDVI y un modelo de simulacién (CropSyst) para estimar la fenologia del cultivo. Esta operacion se
desarrolla en dos pasos principales, el primero es el calculo de la biomasa aérea (AGB), que se obtiene mediante el
uso de NDVI derivado de la fraccién de la radiacién fotosintéticamente activa absorbida (FAPAR), estimado de la
siguiente forma:

fAPAR =bx NDVI —a Eq. 2

AGB=Y"" & x fAPAR x PAR
Eq. 3

Como la fraccién del suelo cubierto por el follaje (fCov) se puede considerar similar a fAPAR en maiz (Edwards et

al, 2005) y soja (Purcell, 2000), esta expresion es reescrita como sigue:

AGB=>" & x fCov, x PAR Eq. 4

Donde ei y PARIi son la eficiencia en el uso de radiacién (RUE, g MJ™!) y la radiacién fotosintética activa (PAR) en el
dia i, respectivamente, y n es el nimero de dias simulados.

El segundo paso consiste en la particién final de la biomasa estimada en el rendimiento del cultivo maximo (Ymax),
que se obtiene a través de la utilizacién del indice de cosecha (HI), donde HI adopta un valor de 0,47 para el maiz y

la soja.

Y max = AGB x HI Eq.5

La evapotranspiracion real (ETa) se puede estimar utilizando diferentes alternativas de calculo en funcién de la
fuentes de informacién disponibles. El balance hidrico del suelo es utilizado habitualmente, pero necesita datos de
precipitacién (PP) y evapotranspiraciéon maxima (ETmax) del cultivo, asi como informacién sobre el tipo de suelo y
su capacidad para retener agua. De una manera similar pero mas simplificada, los valores de NDVI se consideran
sustitutos de la tasa de transpiracion (Funk y Budde, 2009) y, por lo tanto, el modelo de productividad de la FAO se
puede adaptar de acuerdo con la siguiente expresion:

LI > NDVia Fa. 6
Y max ' D_NDV Imax
Dénde XNDVIa es el valor de NDVI acumulado durante todo el ciclo o en cada etapa de desarrollo, y XNDVImax

el valor acumulado mas alto de todos los campos.

El Gobierno de la provincia de Cérdoba compila las estadisticas de la produccién agricola que obtiene a partir de
métodos tradicionales basados en encuestas de campo para establecer la supetficie plantada/cosechada, rendimiento
y produccién de los cultivos de importancia econémica a escala de departamento (SAyGA, 2010). Estos métodos son
labotiosos, requieten personal de campo y no generan resultados de manera tan inmediata como exigen los mercados

agricolas (Rosenthal et al., 1998).).
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1.2 Objetivo de la aplicacion

Esta aplicacién propone desarrollar un procedimiento semi-operativo para estimar los rendimientos de maiz y soja en
la Provincia de Cérdoba, Argentina. El procedimiento se llevarda a cabo en un marco regional haciendo uso de
diferentes rutinas del programa ILWIS para calcular los componentes del modelo de productividad de la FAO, a

pattir de datos de NDVI del satélite MODIS, e informacién de campo local (i sit4).

1.2.1. Recopilacion de datos y preprocesamiento

1.2.2. Datos de NDVI

Asegurese de que ha descomprimido los datos del ejercicio y compruebe su posicion mediante el navegador de
ILWIS en este directorio activo de trabajo. Cierre el programa e inicie nuevamente una sesién de ILWIS para
asegurarse de que la configuracion del ditectorio es la cortecta. Puede echar un vistazo a los datos que estan
disponibles en esta carpeta, abrir el mapa (imagen) de la lista "sub_modis_ndvi" y mostrar la lista de mapas como una
secuencia animada, utilizando "NDVI1" como representacion. Patra esta aplicacion fueron seleccionadas 17 imdgenes
raster NDVI (MODIS-MOD13Q1, producto de 16 dfas, 250 m, del sector h12v12, en formato ENVI), desde
septiembre de 2005 a mayo de 2006. Estas imagenes fueron transformadas al formato de imagen ILWIS y un sub-

mapa fue preparado para cubrir la region de interés. Mas detalles figuran en el cuadro 7.1.

Nombre del archivo raster Desde Hasta SRAD
sub_modis_ndvi_1.mpr 6-Sep-05 21-Sep-05 11.6
sub_modis_ndvi_2.mpr 22-Sep-05 7-Oct-05 16.8
sub_modis_ndvi_3.mpr 8-Oct-05 23-Oct-05 18.2
sub_modis_ndvi_4.mpr 24-Oct-05 8-Nov-05 19.8
sub_modis_ndvi_5.mpr 9-Nov-05 24-Nov-05 20.7
sub_modis_ndvi_6.mpr 25-Nov-05 10-Dec-05 21.6
sub_modis_ndvi_7.mpr 11-Dec-05 26-Dec-05 20.5
sub_modis_ndvi_8.mpr 27-Dec-05 11-Jan-06 23.1
sub_modis_ndvi_9.mpr 9-Jan-06 24-Jan-06 23.3
sub_modis_ndvi_10.mpr 25-Jan-06 9-Feb-06 19.0
sub_modis_ndvi_11.mpr 10-Feb-06 25-Feb-06 19.6
sub_modis_ndvi_12.mpr 26-Feb-06 13-Mar-06 22.2
sub_modis_ndvi_13.mpr 14-Mar-06 29-Mar-06 18.2
sub_modis_ndvi_14.mpr 30-Mar-06 14-Apr-06 17.6
sub_modis_ndvi_15.mpr 15-Apr-06 30-Apr-06 13.8
sub_modis_ndvi_16.mpr 1-May-06 16-May-06 15.8
sub_modis_ndvi_17.mpr 17-May-06 1-Jun-06 14.1

Tabla 7.1 Imdgenes NDVI utilizadas, detalle temporal y datos de radiacion solar diaria de la estacion
Manfredi INTA (SRAD, MJ m?).

1.2.3. Mapa de los limites administrativos (departamentos)

Los limites administrativos se han obtenido a partit de un mapa vectorial con los limites departamentales de la
Provincia de Cérdoba. Este mapa vectorial originalmente en formato de intercambio (DXF), fue importado a ILWIS
y ha sido nombrado "boundary". En “Display Opciones” agregue el archivo de poligono "boundary" a la ventana de

visualizacién del mapa (imagen) activo, usando "informacién off" y "Boundary only".

1.2.4. Datos meteoroldgicos

El procedimiento utiliza los datos diarios de radiacién solar de la estacién meteorolégica de Manfredi (31° 49' 12"S,
63° 46' 00"W, altitud 292 m s/n/m), que estd ubicada en la zona central de Cérdoba. A partir de estos datos se

calcul el valor acumulado por cada periodo de la imagen (véase la Tabla 7.1).

1.25. Mediciones de la fraccidn de suelo cubierta por el cultivo (fCov)

Mediciones de campo de fCov fueron realizadas a partir de fotograffas digitales que se clasificaron con un algoritmo

de mdxima verosimilitud, como se muestra en la figura 7.1. Fotos de cultivos de soja y maiz se recolectaron durante 3
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afios, incluyendo el ciclo de cultivo 2005-20006, en varios campos en la regién central de Coérdoba. Las fotos fueron

tomadas verticalmente desde una altura de 1,5 m. Un total de 150 imdgenes se clasificaron para soja y mafz.

r

[ : A

Figura 7.1 Medlczones de I'Cov en maiz, con Ia foto original (izquierda) y Ia imagen clasificada (derecha)

Los valores de fCov se analizaron mediante regresion con el NDVI para obtener un modelo de estimacion que se

utilizé en ambos cultivos. L.a modelo utilizado es el siguiente:
fCov =1,228x NDVI - 0,245

1.2.6. Datos departamentales de rendimiento de los cultivos

Eq. 7

La Secretarfa de Agricultura de la Provincia de Cérdoba elabora y suministra estadisticas de la produccion agricola a
nivel departamental. Las mismas se elaboran a partir de métodos tradicionales basados en informes y relevamiento de
campo pata establecer la supetficie plantada, cosechada, rendimiento y produccién de los cultivos de importancia

economica en la region (SAyGA, 2010). Los detalles figuran en la Tabla 7.2.

Numero de Rendimiento (kg ha?)

. . . Departmento .

identificacion Maiz Soja
1 Calamuchita 7.000 2.442
2 General Roca 6,800 2,300 5‘“
3 Gral. San Martin 5,500 2,150 J::,:”;'/
4 Juatez Celman 6,000 2,370 T
5 Marcos Juarez 8,000 3,300 | ’,’k
6 Pte. R. S. Pefia 6,500 2,200
7 Rio Cuarto 4,000 2,000
8 Rio Primero 6,000 2,200
9 Rio Segundo 7,000 2,300
10 San Justo 5,500 2,050
11 Santa Maria 6,500 2,400
12 Tercero Arriba 6,500 2,800
13 Union 7,000 2,442

Tabla 7.2 Rendimientos de maiz y soja en los principales Departamentos agricolas de Cordoba en la
temporada de cultivo 2005-2006.
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13. Metodologia

El diagrama de flujo que muestra el procedimiento seguido para estimar el rendimiento de grano se presenta a

continuacion en la Figura 7.2.

@ novi @ srap

¢ h 4 ¢ h 4

e Image .
Classification O noviacou © fcov” PAR

O rPaR=3RAD* 0.5

A

Pixel is Soybean? = o Whax=F (fov " PAR) e *HI
VS £=185 DM M|
h 4
NG
] b @ va=Ymax-¥max*Ky*[1-FNDVI/ENDVImax)
YES £=3.8g DM M)
Pixel is Corn? i
© image masking
NO
ﬁND— Pixel Yiekd is D Departmental
\ Mo Data Wield

IIKEMD — Pinel Yield

Figura 7.2 Diagrama de flujo con Ia metodologia adoptada

1.4. Procesamiento y analisis de los datos

Los distintos pasos del procesamiento, como se indican en la figura 7.2, se presentan en forma mds pormenorizada a

continuacion.

14.1. Imagenes de NDVI (paso @)

Una vez més despliegue una de las 17 imigenes de NDVI, abra la lista (pila) de mapas "sub_modis_ndvi" y muestre
como ejemplo la ptimera de ellas "sub_modis_ndvi_1", utilizando para “Representation” la paleta "NDVI1". Tenga
en cuenta que la mayorfa del pre-procesamiento necesatio ya se ha hecho, esto principalmente con el fin de limitar el
tamafio de los archivos necesarios para realizar el ejercicio. Compruebe los valores de mapa pulsando el botén
izquierdo del ratén y recorriendo con el ratén sobre la ventana del mapa activo. Tenga en cuenta el intervalo de
tiempo de cada una de las imagenes NDVI como figura en la Tabla 7.1. Afiada a la ventana del mapa activo el

archivo de poligono "boundary", utilizando la opcién de visualizacién "Boundaries Only". Desde el menua del mapa
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activo Map Window, seleccione “File =>Open Pixel Information”. Compruebe el contenido de la imagen desde la
ventana de informacién de los pixeles, y observe que se han afiadido los datos del rendimiento depattamental de los
cultivos, idénticos a los de la Tabla 7.2. Muévase con el cursor sobre el departamento situado mas al norte, llamado
San Justo y tenga en cuenta los efectos negativos sobre los valores de NDVI del cuetpo de agua adyacente. Estos
valores negativos de NDVI no representan la vegetacion y, por lo tanto, estos valores seran reclasificados como
“valores sin datos". Cierre todas las ventanas de mapa activas. Ahora desde la ventana principal de ILWIS, seleccione
las opciones “Operations => Raster Operations => Maplist Calculation”. Llene la ventana de calculo MapList como
se indica en la Figura 7.3 y pulse el botén "Show" para ejecutar la operacién. Muestre el resultado de MapList
"sub_modis_ndvi_und" como una secuencia animada y revise los valores, considerando que donde no hay datos esta

representada por un "?"

X

Expraszion
HiE1>=0.E1.7)

St Band [l_= endeond 17 =
Inpul Maplists  [1 -
Meplit@1  [@sbmodis e v |

Output Maplist  [sub modis_ad_und |

Digscription;
[NCVI below D assigned no data value |

Shiwe ] Diines ] Cancnl |

Figura 7.3 Reclasificacion de los valores negativos de NDVI como valores sin dato (?)

1.4.2. Radiacion solar (paso @)

Los valores de radiacién solar utilizados se presentan en la Tabla 7.1 (ver columna SRAD), y se describen en la

seccién Datos meteoroldgicos en el Capitulo 7.3.3.

14.3. Clasificacion de cultivos (paso @)

1 Para evaluar la existencia de diferentes cultivos se adopté un método de

_'é\g;iean N clasificacion multicritetio a partir del conocimiento de ciclos fenolégicos de

‘\ ‘ maiz y de soja en la provincia de Cérdoba, de acuerdo a lo que se refleja en
\‘\‘ / \ los petfiles de NDVI, véase también la figura 7.4. La soja se cultiva en dos
T ~ formas diferentes: la soja tardia (soybean_2) se siembra después del trigo,

por lo que se espera que los valores de NDVI de septiembre sean altos, son

! mas bajos en diciembre en el momento de la cosecha, hasta alcanzar un

E:;gean ,/ \ maximo en febrero, cuando la cubierta de soja se completa. Siguiendo este
criterio se puede calcular un mapa raster booleano escribiendo la siguiente

/ \ expresion en la linea de comandos del menu principal de ILWIS:

soybean_2:=iff((sub_modis_ndvi_und_1>0.6)and(sub_modis_
1 ndvi_und_7<0.3) and(sub_modis_ndvi_und_11>0.7),1,0)

o

Pulse Enter para ejecutar la operacién y, después de realizar el calculo,
/ L presente el mapa en pantalla. Por otro lado, como la soja temprana
. ST (soybean_1) se realiza después del descanso invernal, el NDVI de

septiembre es bajo. La siembra de la soja se inicia en noviembre de modo

Figura 7.4 Petfiles del NDVI que el NDVI méximo aparece a finales de diciembre y luego desciende al

producirse la cosecha. Para separar este cultivo se utiliza la siguiente expresion:
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soybean_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_8>0.7)and(sub_modis_ndvi_und
_12>0.5)and(sub_modis _ndvi_und_15<0.3),1,0)

Para el maiz, similar a la soja temprana, el valor minimo de NDVI se produce en septiembre, pero como las

necesidades térmicas de este cultivo son inferiores a la soja, la siembra suele ser anterior por lo que su valor maximo

de NDVI ocurre antes en noviembre (corn_1) o diciembre (corn_2). Las expresiones utilizadas para la clasificacion

del maiz son:
corn_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_6>0.6)and(sub_modis_ndvi_und_15
<0.3),1,0)

corn_2:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_7>0.7)and(sub_modis_ndvi_und_12
<0.5)and(sub_modis_ndvi_und_15<0.3),1,0)

Ejecute estas expresiones desde la linea de comando del menu principal de ILWIS, muestre en pantalla y verifique los
resultados. Para este ejercicio sélo necesitamos conocer dénde se cultiva soja y maiz porque los cultivos poseen
diferente valor de eficiencia en el uso de la radiacién (g), para eso realice un unico mapa Booleano para cada cultivo

usando los siguientes comandos:

soybean:=iff((soybean_1=1)or(soybean_2=1),1,0)
corn:=iff((corn_1=1)or(corn_2=1),2,0)

Para verificar los resultados de la clasificacion, basicamente para comprobar si los cultivos fueron clasificados dos
veces, se puede agrupar los dos cultivos en un mismo mapa, usando las siguientes expresiones desde la linea de

comando del ment principal de ILWIS:
class_check:=corn+soybean

Ahora se propone abrir el mapa (imagen) creado usando como “Representation” la paleta “lai_ SAF” y chequear los
resultados, notando que los valores tesultantes presentan un rango entre 0 y 3, ya que al maiz se le ha asignado un
valor de 2! Cierre el mapa y presione el botén derecho del ratén sobre el mapa “class_check”, directamente desde el
menud sensitivo de contexto, seleccione la opcién “Statistics => Histogram” y presione “Show” para ver las
estadisticas por clase. Para corregir el error de clasificacioén, debe ejecutarse la siguiente expresion desde la linea de

comando del menu principal de ILWIS:
class_cor:=iff(class_check<3,class_check,0)

Visualice el mapa usando la paleta “lai_ SAF” como Representation y vetifique sus resultados, note que el rango de
valores ahora es entre 0 y 2, la soja ahora estd clasificada con el valor de 1 y el maiz ha obtenido un valor de 2.
Finalmente, debe ser considerada la distribucién de los pixeles clasificados por departamento. Pulse el botén derecho
del ratén sobre el mapa de poligonos “boundary”, desde el mend de contexto sensitivo, seleccione la opcidén
“Polygon to Raster”, como Output Raster Map, mantenga “boundary”, use como Georeference
“sub_modis_ndvi_1" y presione “Show”. Note que el mapa ha sido remuestreado al sistema de georreferencia del
NDVI, el cual esta en la proyeccién original de MODIS, denominada Proyeccién Sinusoidal, por lo tanto los limites
patecen estar distorsionados. El proximo paso consiste en cruzar el mapa raster “boundary” con el mapa “class_cot”,
seleccione desde el mend principal de ILWIS la opciéon “Operations => Raster Operations => Cross” , como 1%
Map especifique “boundary” y como 2" map seleccione “class_cotr”, como Output Table especifique
“representation_department” y presione “Show”. Verifique los resultados que muestra la tabla en pantalla,

escribiendo las siguientes expresiones en la linea de comando:
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pixel_soybean:=iff(class_cor=1,npix,?)

pixel_corn:=iff(class_cor=2,npix,?)

Nuevas columnas son creadas que muestran el nimero de pixeles que representan maiz y soja por departamento.
Estas dos nuevas columnas creadas seran afiadidas a la tabla de atributos “boundary”. Cierre la tabla
“representation_department” y abra la tabla “boundary”. Desde el menu de la tabla activa, seleccione la opcion
“Column => Join”, como Table seleccione “representation_department” y como Column “pixel_soybean”, presione
“Next” 4 veces, acepte por defecto Output Column “pixel_soybean” y presione “Finish” y “OK”. Repita este
procedimieto para unir también la columna “pixel_corn”. Sus resultados deberfan aparecer como muestra la Figura
7.5

Hl Table “boundary” - ILWIS

Fle Edit Columns Records View Help

B X & e @y

|pixeLc0rn = ColumnJoinAvg(representation_department.tbt,pixel_corn,boundary,1) j

I[@ CornY¥ield |Soybean¥ield pixel soybean pixel corn J
Calamuchita 7000 2442 1249 13
General Roca 6800 2300 1704 927
Gral San Martin 5500 2150 1200 745
Juarez Celmwan e000 2370 Z837 1432
Marcos Juarez §o0o 3300 4564 768
Pte R3S Pena 6500 2200 2592 B8
Rio Cuarto 4000 2000 8075 2659
Rio Primero 6000 2200 4329 425
Rio Segundo 7000 2300 8152 491
San Justo 5500 2050 2378 151
Santa Maria 6500 2400 6647 188
Tercero Arriba 6500 2800 5531 621
Union 7000 2442 5537 1460

Min 4000 2000 1249 13
Hax 5000 3300 8152 2659
Ay £331 2381 4270 821

StD =) 343 2385 o6

Sum §z300 30954 55515 10676 JJ

Figura 7.5 Rendimiento y niimero de pixeles por Departamento para maiz y soja

144, Suma de NDVI (paso @)

Para calcular la suma de NDVI a partir de la totalidad de imagenes a lo largo del ciclo del cultivo (desde la banda 7 a
14) se emplea la utilidad Maplist Statistics para obtener la imagen ndvi_sum. A partir de la ventana principal de
ILWIS, seleccione la opcién “Operations => Statistics => MapList =>Maplist Statistics”. Complete la ventana

MaplList Statistics como se muestra en la figura 7.6 y presione “Show” para ejecutar la operacién.

Maplist Statistics

haplist |@sub_modia_ndvi_und ﬂﬁ
Statistic function | fn Sum ﬂ
Startband [ =1 Endhand 14 =

Output RasterMap  [ndvi_sum |

Description:
Isum MDY during Crop Cycle| }

Show ‘ Define ‘ Cancel |

Figura 7.6 Funcion MapList Sum

Muestre el mapa tesultante “ndvi_sum” usando como tepresentacion la paleta “lai” y observe los valores maximo y

minimo del mapa. Mueva el ratén con el botén izquierdo presionado sobre la ventana del mapa activo.

1.4.5. Célculo de fCov*PAR (pasos @ y @)

El valor de fCov es calculado empleando la ecuacién 7 (ver capitulo 7.3.4), para cada uno de los mapas de NDVI

obtenidos durante el ciclo del cultivo (desde la banda 7 a 14). Esto puede ser combinado con el promedio de la
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radiacion solar transformada a PAR (PAR=SRAD*0.5) para un periodo de 16 dias (ver tabla 7.1). Escriba la siguiente

expresion en la linea de comando del ment principal de ILWIS:
fCov_PAR7:=(sub_modis_ndvi_und_7*1.228-0.245)*10.25*16

emplee los valores por defecto y presione “OK?”. Para la primer fecha, donde la radiacién solar fue 20.5, 1a PAR es
10.25 Mj m? d. Muestre el mapa resultante y controle los valores obtenidos, emplee como Representacion
“Pseudo”. Repita este procedimiento para todos los otros mapas correspondientes al ciclo del cultivo empleando las

siguientes expresiones (note el cambio de los valores de PAR):

fCov_PARS8:=(sub_modis_ndvi_und_8*1.228-0.245)*11.55*16
fCov_PAR9:=(sub_modis_ndvi_und_9*1.228-0.245)*11.65*16
fCov_PAR10:=(sub_modis_ndvi_und_10%1.228-0.245)*9.5*16
fCov_PAR11:=(sub_modis_ndvi_und_11*1.228-0.245)*9.8*16
fCov_PAR12:=(sub_modis_ndvi_und_12%1.228-0.245)*11.1*16
fCov_PAR13:=(sub_modis_ndvi_und_13*1.228-0.245)*9.1*16
fCov_PAR14:=(sub_modis_ndvi_und_14*1.228-0.245)*8.8*16

Cree un Nuevo MapList a partir de todos los mapas fCov_PAR* resultantes, a partir del menu principal de ILWIS,
seleccione “File => Create => MapList”, especifique un nombre de Map list “fCov_Par” y agregue los mapas en

orden secuencial usando el signo “>. Ver también la figura 7.7.

Create MapList

Map List fCov_PAR

Description I

[hfcow_par?
B foov_pard
R fcov_pard
<

| €

oK Cancel | Help
Figura 7.7 Maplist de fCov. PAR Final

1.4.6. Rendimiento Maximo — Ymax (paso @)

Como se muestra en el diagram de flujos (ver figura 7.2), Ymax se calcula empleando la suma de fCov_PAR,
multiplicada por la Eficiencia en el Uso de la Radiacién () y el Indice de Cosecha (HI). Para calcular
fCov_PAR_sum, emplee la opciéon Maplist Statistics. A partir del menu principal de ILWIS, seleccione las opciones
“Operations => Statistics => MapList =>Maplist Statistics”. Complete la ventana MapList Statistics como se

muestra en la figura 7.8 y presiones “Show” para ejecutar la operacion.

Lﬂ; Maplist Statistics

MapList [@iCov_PAR ~| J
Stafistic function |fn Sum ﬂ
Startband [ =] Endhand [8_=
Output RasterMap  [fCov_Par_sum |
Description:

[sum fCov_PAF] |

Showe ‘ Define | Cancel |

Figure 7.8 Funcion SUM de fCov._PAR de MapList Statistics
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Como existen valores negativos, este mapa intermedio es cotregido y todos los valores negativos son reasignados

como indefinidos (?). Esctiba la siguiente expresion en la linea de comando del ment principal de ILWIS:
fCov_PAR_sum_cor:=iff(fCov_Par_sum ge 0,fCov_Par_sum,?)

Use la configuracion dada en la figura 7.9 para “Raster Map Definition” y presione“OK” para ejecutar la operacion.

Lﬂ; Raster Map Definition

Map Calculate "“Cov_PAR_sum_caor"

Expression IIﬁ(TCUV_Par_sum ge 0LiCov_Par_sum.?) ]

Domain  |Ewvalue - J Defaults
DefaultValue Domain

Yalue Range [L] M]

Precision [L]

Desc, [iﬂ(iCDD_Par_aum e 01Coc_Par_sum.?)| ]

Map will use 4 bvtes per pixel

Figura 7.9 Definiciones de Mapa de Raster

Para estimar el rendimiento maximo (Ymax) para cada cultivo se tuvieron en cuenta diferentes valores de e (1.8 gr
Mj-1y 3.8 gr Mj-1 para soja y maiz, respectivamente (Sinclair and Mochow, 1999; Lindquist e/ /., 2005). Para ambos
cultivos se asumié un indice de cosecha (HI) de 0.47. Para obtener el rendimiento estimado en kg ha-1 se necesita
aplicar un factor de conversion de 10. Esos cilculos pueden realizarse empleando una sola expresion en la linea de

comando del menu principal de ILWIS:

Ymax_soybean:=iff(class_cor=1,fCov_Par_sum_cor*1.8%0.47*10,?)

Ymax_corn:=iff(class_cor=2,fCov_Par_sum_cor*3.8*0.47*10,?)
Ejecute ambas expresiones y controle los mapas resultantes.

147. Rendimiento Real - Ya (paso ®)

A partir de datos experimentales el valor de NDVImax acumulado obtenido a partir de un conjunto de 10 lotes
dentro del area de estudio fue 7.6 para todo el ciclo del cultivo. Para considerar diferente sensibilidad de los cultivos
al estrés hidrico, se utiliz6 un valor de Ky de 2.1 y 1.3 para soja y maiz, respectivamente. Los comandos de ILWIS

pata calcular el rendimiento real se muestran a continuacion:

Ya_soybean:=iff(class_cor=1,Ymax_soybean-Ymax_soybean*2.1*(1-ndvi_sum/7.6),?)

Ya_corn:=iff(class_cor=2,Ymax_corn-Ymax_corn*1.3*(1-ndvi_sum/7.6),?)

Ejecute las expresiones y muestre los mapas resultantes, controle los valores obtenidos.

1.48. Enmascaramiento de Imagenes (paso @)

Visualice el mapa “Ya_soybean” y agréguele el mapa de poligonos “boundary” empleando Display Options Info off
and Boundaries Only. Repita este procedimiento una vez mas utilizando el mapa “Ya_corn” y controle la
distribucién de aquellos pixeles que han sido empleados para calcular el rendimiento de maiz y soja, respectivamente.
También emplee la opcién “Pixel Information”, seleccione “File => Pixel Information” a partir de la ventana active

map display. Cierre todas las ventanas active map.
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1.4.9. Rendimiento Departamental (paso @)

Para obtener el rendimiento promedio por departamento, el rendimiento de cada region administrativa para cada
cultivo debe ser extreido y agregado para obtener el rendimiento promedio. Para hacer esto seleccione de la pantalla
principal de ILWIS en el menu opciones “Operations => Raster Operations => Cross”, como 1%t Map seleccione
“boundary” y como 2°¢ map “Ya_corn”. Como Output Table especifique “department_corn” y presione “Show”
para ¢jecutar la operacion. Abra la tabla “department_corn” y fijese en el contenido de la tabla. A partir del menu
tabla, seleccione la opcion “Columns => Aggregation” y especifique las opciones de la ventana Aggregate Column
como se indica en la figura 7.10 (izquietda) y presione “OK”. Note que el rendimiento promedio para maiz es
calculado por depattamento y el resultado es agregado a la tabla “boundary”, utilizando una nueva columna, llamada

“Ya_corn”. Cierre la tabla cruzada.

Repita la operacién cruzada, ahora usando como 15t Map “boundary” y como 22 map “Ya_soybean”. Como Output
Table especifique “department_soybean” y presione “Show” para ejecutar la operaciéon. De nuevo note el contenido
de la tabla creada. Emplee nuevamente la funcion aggregation como se muestra en la figura 7.10 (derecha), utilice

ahroa la columna “Ya_soybean”, como output table especifique “boundary” y como output column “Ya_soybean”

geregate Column _ Aggregate Column
Colurmin ) Ya_cam - Colurmn [va_sovbean -
Function fn Average ﬂ Function fn Awverage ﬂ
[ Group by i boundary - v Group by [y boundary -
[ wWeight [ wWeight
[+ Output Table [bDundary ] [v' Output Table [buundary ]
Output Column 'va_com| Output Column v'a_sovbean

oK. | Cancel| Help | oK | Cancel| Help ‘

Figura 7.10 Tabla de Agregacion del rendimiento de maiz-soja por Departamento

Ahora abra la tabla “boundary” es inspeccione las columnas recientemente creadas denominadas “Ya_corn” y
“Ya_soybean”. Fijese también en la figura 7.11. A partir del menu table, seleccione las opciones “Columns =>
Statistics”, seleccione como funcién “Correlation” y calculi la correlacién enttre las columnas “CornYield” —

“Ya_corn” y entre las columnas “SoybeanYield” — “Ya_soybean”.

fl Table “boundary” - ILWIS

File Edit Columns Records View Help
=] t | | b

‘? corr(SoybeanYield Ya_soybean) j
I(@ CornVield |Soybean¥ield pixel soybean|pixel corn ¥a corn Ta_soybean J
Calamuchita 7000 z442 1243 13 4741.619 2773.733

General Foca 6300 z300 1704 9z7 5065.304 2195.645

Gral San Martin 5500 z150 1900 745 £491.534 2525.529

Juarez Celman 6000 2370 2837 1432 6255.835 2827.619

Marcos Juarez 2000 3300 4554 766 7097.131 3611.839

Pte RS Pena 6500 zz00 2592 788 6258.860 2359.127

Rio Cuarto 4000 z000 8075 2659 5403.034 2945.936

Rio Primero 6000 2z00 4329 425 TT64.826 3025.973

Rio Segundo 7000 2300 8152 491 7000.258 3045.731

dan Justo 5500 2050 2378 151 5836.679 2674.932

Santa Maria 6500 z400 6647 198 6984.910 3025.209

Tercero Arriba £500 2800 5531 621 £151.753 2909.456

Union 7000 2442 5537 14560 6578.396 2805.232 J
Min 4000 z0o0 1243 13 4741.619 2195.645 J
Max 2000 3300 8152 2659 7764.826 3611.839

hvg 8331 2361 4270 azi 6279.2486 2640.669

StD 978 343 23885 706 853.636 355.027

SJum &2300 30954 55515 10676 S1630.204 36928.960 JJ
Sum of walles in column: Cornvield

Figura 7.11 Tabla que muestra los rendimientos observados versus calculados.
Para calcular los errores de la estimacién escriba las siguientes ecuaciones en la linea de commandos de la tabla y

presione “OK” para ejecutarlas:
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Res_corn:=cornyield-ya_corn

Res_soybean:=soybeanyield-ya_soybean

A partir del menue Table, seleccione el icono “Graph”, en el mend “Create Graph”, desmarque el “X-Axis” y
seleccione el “Y-axis” la columna “Res_corn” y presione “OK”. En la leyenda del grafico de la izquierda, haga doble
click en el item ”Res_corn” y cambie la representacion a “Line”. A partir del menu Graph, seleccione “Edit => Add
Graph => From Columns” y seleccione la columna “Res_soybean” y presione “OK”. Nuevamente haga doble click
sobre el item “Res_soybean” en la leyenda del grafico y cambielo a representacion como linea, eventualmente cambie
su color. Haga doble click en el titulo del grafico y cambie el nombre, repita lo mismo para la descripcion del eje Y.

Sus resultados debieran ser similares a los de la figura 7.12.

File Edit Wiew Help
=EHE &~

Residual analysis

| Graph -
fbe Residual analysis i
B % Legend
@ boundary 1500
| X-Axis

Abe
| Y-Axis Left

fbs Res_cor and Re
-2167
2379
i ¥-Axis Right

Abe

- Res_soybean
- Res_com

yhean

m

=)

=]
|

-1000+

Res_com and Res_so

-2167

2379

i — - Res_soybean 20004
| Res_sovbean L T T T T | T T T T T T T T

& —— -Res_com 6\“&‘;\@ g\t@& G"W 5 @‘ ?e@ 03@{& ?&“@,‘ ge@)ﬂw 5\55‘0 R ‘m‘\a o R % ey
[F1 Res corn oo e@\c;?ﬁ‘ Na‘e'b ‘&@‘dﬁ Q"- oL et e ec,

1500+

Figure 7.12 Andlisis Residual de los rendimientos observados versus los estimados

1.5. Conclusiones

Este ejercicio muestra una metodologia que fue desarrollada empleando un sistema de informacién geografica para
estimar los rendimientos de soja y maiz para la Provincia de Cérdoba, Argentina, aplicando unicamente datos de
NDVI (obtenidos a partir de MODIS, con un tamafio de pixel de 250 m) y radiacién solar como informaciéon de
superficie.

Este procedimiento es un primer prototipo que, a pesar de su disefo simplificado, produce resultados objetivos que
contrastan con los que produce el método de encuestas actualmente empleado por la agencia estatal, de cardcter mas
cualitativo. Debe notarse que en general muy pocos pixeles han sido empleados para calcular el rendimiento
promedio de maiz, para el Departamento de Calamuchita sélo 13 pixeles se han utilizado. Esto podria explicar el alto
valor de residuo obtenido por lo que en general se requeriria una validacién posterior de la metodologfa.

El método de productividad de la FAO estructurado en un sistema de informacién geografico es flexible para
incorporar rutinas de calculo de manera modular. De acuerdo con la informacién disponible la estimacion de Ymax,
ETmax y Eta pueden cambiarse empleando metodologias mds precisas peto por lo general mds complejas.

En una etapa postetior, la mejora del procedimiento debiera tener en cuenta también la diferente sensibilidad al
estrés hidrico de los cultivos en sus distintas etapas fenoldgicas, como asi también el empleo de informacién de
precipitacién distribuida espacialmente, empleando estimadores derivados de satélites.

Ademas, el NDVI derivado de MODIS podria ser reemplazado por datos NDVI obtenidos a partir de MSG
(SEVIRI-Instrument) que actualmente esta disponible.
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Capitulo 8. Estimacion de la productividad primaria neta aérea en pastizales de la Regidn
Pampeana utilizando informacién MODIS y GOES

Piedad M. Cristianol, Maria Eugenia Beget2 , Carlos Di Bellal2, Gabriela Posse2 and Tomas
Hartmann2

1 CONICET Buenos Aires, Argentina Corresponding Author (email: piedad78@gmail.com)
2 Instituto Nacional de Tecnologia Agropecuaria (INTA), Corresponding Author (email: mbeget@cnia.inta.gov.ar)

8.1 Importancia de la aplicacion

La productividad primaria (PP) de los ecosistemas es una variable clave que define las entradas de
carbono al sistema. Particularmente en areas de produccidn ganadera extensiva, donde las pasturas
y los pastizales constituyen la principal fuente de recursos forrajeros que sustentan la produccion,
estimaciones precisas de la productividad primaria neta aérea (ANPP) son representan una
herramienta esencial para ajustar la demanda forrajera y mejorar el manejo sustentable. Se
generaran mapas mensuales de ANPP destinados a productores ganaderos, asociaciones
cooperativas y decisores gubernamentales para ser utilizados como una herramienta para optimizar
el desarrollo de sus actividades.

8.2 Objetivos de la aplicacion

De manera de proveer una herramienta Util para el cdlculo del balance forrajero para
establecimientos de un drea de la Region Pampeana, el objetivo general es generar un mapa de ANPP
utilizando el modelo de eficiencias propuesto por Kumar y Monteith (1982). El objetivo particular del

ejercicio es calcular la ANPP para el aifo 2007.

8.3 Metodologia

La ANPP regional es calculada aplicando el modelo de eficiencia propuesto por Kumar y Monteith
(1982), y se generaran mapas de un drea de la Region Pampeana, mensual y anual para el afio 2007.
La metodologia se encuentra representada en la figura 8.1. El modelo relaciona linealmente la ANPP
con la radiacién fotosintéticamente activa (PAR) absorbida por la vegetacion (APAR) y la eficiencia del
uso de la radiacion (RUE), la cual es el coeficiente de conversion de la radiacidon absorbida en biomasa
aérea. El modelo puede expresarse como: ANPP = RUE * APAR (Kumar y Monteith, 1982). La APAR
puede calcularse multiplicando la fraccion de PAR interceptada por la vegetacién (fPAR) por la PAR
incidente. El modelo tiene como ventaja la utilizacién de informacion espectral provista por sensores
remotos, como el indice NDVI para estimar la fPAR.

Un mapa de RUE fue previamente creado de manera de representar distintas condiciones
ambientales de disponibilidad de agua y nutrientes en la regidn. Este mapa es utilizado para la
estimacion regional de la ANPP junto con informacién derivada de sensores remotos.

El drea de estudio incluye parte de tres provincias Argentinas pertenecientes a la Region
Pampeana: norte de Buenos Aires, sur de Entre Rios y sur de Santa Fe (ver figura 8.2). Esta region es

caracterizada por vegetacion de pastizal intensamente modificada por la actividad agricola y
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ganadera. La mayores precipitaciones se registran en los meses de primavera-verano y su intensidad
decrece de este a oeste, con una media de 900 mm. La temperatura media anual es 152C con una
media mensual ente 72C en invierno y 212C en verano. Debido a la estacionalidad en las condiciones
hidricas el mapa de RU fue generado para cada estacion, la estacién seca (otofio-invierno) y la
estaciéon humeda (primavera-verano). La disponibilidad de nutrientes considerada en el mapa de RUE
fue derivada del Atlas de Suelos (INTA, 1995).

10) RUE_* tif NDVI_* tif PAR_* tif
P4
o 1),
g
w ILWIS format
O
(©)
[1g
o RUE_*.mpr NDVI _*.mpr PAR _*.mpr
L
o 4
o Change pixel Subset to @) Change pixel
S|ze/study area study area size/study area
RUE_*.mpr NDVI _*.mpr PAR _*.mpr [—
OF(A+NDVIY(I-NDVI) () gse
4.05
fPAR _*.mpr
;
IffPAR20 | ——
w
> No
— Yes
< Yes Y]
<Zz fPAR = 0.95 If fPAR 2 0.95 fPAR=0
\l, No
<
= fPAR *.mpr
<
[a)]
fPAR x PAR
APAR *.mpr
9)
—>( RUE x APAR
(10) ”
ANPP_*.mpr (Z month ANPF>—> annualANPP_*.mpr ’
1

Figura 8.1: Esquema de la metodologia aplicada.
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Figura 8.2: Area de estudio localizada en la Regién Pampeana.
8.4 Procesamiento y analisis
8.4.1 Introduccién

En primer lugar, asegurese de descomprimir los datos del ejercicio y dirijase al directorio de trabajo
utilizando el navegador de ILWIS. Cierre ILWIS y dbralo nuevamente para asegurarse que el directorio
de trabajo es el correcto. No vera auln ningun archivo en el catdlogo de ILWIS debido a que los datos
no han sido importados. Puede utilizar el Explorador de Windows para verificar los datos disponibles.
Todos los datos se encuentran en formato TIFF. Los datos necesarios para llevar a cabo el ejercicio

son:
. NDVI mensual (ndvi_mmmyys), donde m es el mes, y el afio y s indica que un
submapa es utilizado;
. PAR mensual (par_mmmyy);
. Mapas bi-estacionales de RUE (rue_ss), donde s es la estacidén (primavera-verano u

otofio-invierno).

Las imagenes de NDVI han sido provistas por el sensor MODIS (Moderate Resolution Imaging
Spectroradiometer) a bordo del satélite Terra (NASA). Un submapa fue creado utilizado dos imagenes
gue cubren la regidon de estudio (h12v12 y h12v13). Las imagenes fueron recepcionadas por la
estacion HRPT operada por el INTA. La resolucidn espacial de las imagenes es de 250 x 250 m y la
resolucién temporal de 16 dias. El maximo NDVI fue seleccionado de las imagenes bisemanales
disponibles para cada mes, de manera de descartar los efectos causados por la atmdsfera.

Los mapas de PAR fueron generados a partir del producto mensual de radiacion global media diaria
(W/m2) provisto por el Instituto Nacional de Investigaciones Espaciales de Brasil (INPE). El producto
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estd basado en imdgenes del satélite GOES (Geostationary Observational Environmental Satellite-8 y
12) de 16 km2 de resolucién espacial y 8 dias de resolucion temporal. Estos valores fueron
convertidos a MJ/m2 y acumulados mensualmente para los meses de 2007. Para convertir la
radiacion global a PAR se utilizé un factor de 0.47, presentado por Akmal y Jansen (2004). Se aplicé
un filtro de madiana usando una matriz de 7x7 para difuminar los bordes del mapa.

La RUE fue especializada de acuerdo a los factores de estrés hidrico y nitrogenado considerando las
condiciones ambientales en primavera y verano para los meses de octubre a diciembre, mientras que
los meses de abril a septiembre fue considerado para el periodo de otofio e invierno. El valor de
RUE=0.48 fue considerado como 6ptimo (Paruelo et al. 1997, Clavijo et al. 2007) y en cada condicion
ambiental se aplicd una reduccién en la RUE de acuerdo a lo establecido por Cristiano et al. (en
prensa, 2011).

8.4.2 Pre-procesamiento de los datos

8.4.2.1 Importacion de los datos a ILWIS

Previo al procesamiento de los datos, es necesario convertir los datos a formato ILWIS y
remuestrear las imagenes de PAR y RUE. Para convertir el formato TIFF a formato ILWIS, se debe
ejecutar la libreria de traduccion GDAL desde la linea de comandos de la ventana DOS. El archivo
ejecutable “gdal_translate.exe” estd ubicado en el directorio principal de ILWIS.

Para abrir la ventana de comandos de DOS, selecciones la opcion “Ejecutar” desde el menu de
Inicio de Windows tipeando “cmd” y presionando “ok”. Una vez abierta la ventana de comandos,
cambio el directorio al directorio de trabajo tipeando “cd C:\chapter8” (ver figura 8.3). Tenga en

cuenta que el camino puede ser diferente si usted copid los datos del ejercicio a otro directorio.

ev CAWINDOWS\systemn32icm

C:\»cd chapterd

ih\chapterd3»C i \ILWIS\gdal _translate.exe -of ILWIS C:\chapter®\rus_autwin.tif C:\chapter¥\rue_autwin.mpr

Figura 8.3: Ventana de comandos de MS DOS.

Para importar la capa o imagen al formato ILWIS (paso 1 del esquema de la figura 8.1) utilice la
sintaxis del comando general:

GDAL_translate.exe —of ILWIS inputfile outputfile

donde “-of ILWIS” especifica el formato de salida de la imagen como ILWIS; “inputfile” es el archivo
TIF a importar y “outputfile” es el destino del archivo en formato ILWIS.
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Importe la imagen siguiente tipeando la expresién anterior en la linea de comando (note la
ubicacién de ILWIS y del directorio del ejercicio en su sistema. En este caso ILWIS estd instalado en
“C:\ILWIS” y el directorio de trabajo es “C:\chapter8”) y presione “Enter” to ejecutar la operacion:

C:\ILWIS\gdal_translate.exe -of ILWIS C:\chapter8\ndvi_0107s.tif C:\chapter8\ndvi_0107.mpr

Para desplegar la imagen de NDVI importada haga doble click sobre el archivo creado “ndvi_0107"
usando la Representacién “NDVI1” y presione “Show”. Examine los valores del mapa usando el botén
izquierdo del ratén presionado mientras mueve el cursor sobre el mapa.

Utilice su Explorador de Windows y revise el contenido del directorio una vez mds. Notara un
archivo llamado “import.bat”. Con el botdn derecho sobre éste archivo seleccione “Edit” del menu
contextual para desplegar el contenido del archivo en NotePad o WordPad. Revise el contenido.
Notard que para cada mapa se ha generado una linea de sintaxis, similar a la que usted tiped en la
ventana de linea de comandos. Ademas notard que usted deberia editar cada linea si la ubicacién de
ILWIS y el directorio de trabajo son diferentes. Puede usar “Reemplazar” del menu “Edicion” y
proveer el directorio apropieado. Una vez realizado guarde el archivo, haga doble click con el ratén y
la importacion sera ejecutada usando este archivo “import.bat”. Una vez completada la importacién,
seleccione “Window => Refresh” desde el menu principal de ILWIS. Note que se muestran los nuevos
mapas importados en el catdlogo de ILWIS. Despliegue un ejemplo de mapa de NDVI, RU y PAR,
utilizando la representacion “NDVI1” para el NDVIy “Pseudo” para los otros mapas.

8.4.2.2 Pre-procesamiento de mapas de RUE y PAR

De manera de no realizar el ejercicio con un conjunto de datos demasiado grande se utilizara un
recorte de los mapas de NDVI. De esta manera, el paso 2 del esquema de la figura 8.1 puede ser
omitido. Si queremos calcular in ILWIS utilizando mapas diferentes, éstos deben tener la misma
cantidad de filas y columnas. En este caso los mapas de RUE y PAR tienen diferentes dimensiones,
por lo tanto requieren ser remuestreados al tamafio del mapa de NDVI.

Haciendo doble click sobre el mapa de entrada “rue_sprsum”, seleccione la opcién “Spatial
Reference Operations => Resample” del menu contextual. Seleccione “Nearest Neighbour” como
método de remuestreo y especifique “rue_sprsumr” como nombre del mapa de salida. Seleccione el
mapa de enero “ndvi_0107" como referencia (Georeference). Presione “Show” para ejecutar la
operacion- Despliegue el mapa resultante usando la representacion “Pseudo”. Desde el menu del
mapa activo, seleccione la opcién “Layer => Add Layer” y el mapa “NDVI_0107”. En Raster Map
Display Options marque “Transparent” usando una transparencia del 50% y presione “Ok”. Ahora, los
dos mapas pueden ser desplegados en una misma ventana ya que las dimensiones y el sistema de
coordenadas de ambos son idénticos. Cierre el visor del mapa y repita el procedimiento para el mapa
“rue_autwin” utilizando el mismo método de remuestreo (“Nearest Neighour”) y georreferencia
(“NDVI_0107"). Especifiqgue como nombre de salida “rue_autwinr”, despliegue y revise el mapa
resultante.

De manera similar necesitan ser remuestreados los mapas de PAR. Haga doble click sobre el mapa

de entrada “par_0107”, seleccionado “Spatial Reference Operations => Resample” del menu
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contextual. Seleccione “Nearest Neighbour” como método de remuestreo y especifique “par_0107r"
como nombre de salida del mapa. Seleccione el mapa de enero “ndvi_0107” como referencia
(Georeference). Como rango de valores especifique “-100” y

“1000” como minimo y maximo respectivamente, la precision debe ser la que esta por defecto.
Presiones “Show” para ejecutar la operacidn. Revise el mapa y luego cierre la ventana.

Como esta operacién debe repetirse 11 veces, utilice la historia de la linea de comandos. Desde el
menu principal de ILWIS, seleccione la linea de comandos utilizando la flecha hacia abajo. Seleccione
la linea resultante en el paso anterior de remuestreo del mapa de PAR:

par_0107r.mpr{dom=value.dom;vr=-100:1000} =MapResample(par_0107,ndvi_0107.grf,nearest)

Modifique la linea como sigue y presione “Enter” para ejecutar un nuevo procedimiento de
remuestreo para el mapa de PAR de febrero:

par_0207r.mpr{dom=value.dom;vr=-100:1000}:=MapResample(par_0207,ndvi_0107.grf,nearest)

Repita el procedimiento descripto arriba para remuestrear los mapas de PAR restantes. Al finalizar,
todos los mapas de PAR y RUE han sido remuestreados y pueden ser utilizados en conjunto con los
mapas de NDVI del afio 2007 (ver figura 8.4).
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Figura 8.4: Recorte del mapa NDVI_0107 y remuestreo de los mapas RUE_sprsumr y PAR_0107r
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8.4.3 Analisis de los datos

El calculo de la fraccion de PAR interceptada (fPAR, paso 5 en el esquema de la figura 8.1) serd
realizado de acuerdo al procedimiento propuesto por Potter et al. (1993) indicado en la ecuacidn 1.

(1+ NDVI)

fPAR = M —0.2666 (Ec.1)

Para calcular el mapa de fPAR en base mensual una nueva lista de mapa debe ser creada. Desde el
menu principal de ILWIS seleccione “File => Create => MapList” y agregue todos los mapas “NDVI_*"
en orden secuencial hacia la lista de la derecha utilizando el icono “>”. Especifique como nombre la
lista en Map List: “NDVI_07” y presione “Ok”. Despliegue la lista de mapa creada en una secuencia
animada utilizando “NDVI1” como representacidn y revise los valores del mapa obtenido.
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Desde el menu principal de ILWIS seleccione “Operations => Raster Operations => MaplList

Calculation”. Especifique la expresion indicada en la figua 8.5 y presione “Show” para ejecutar la

operacion. Despliegue la lista de mapa creada “fPAR” como secuencia animada usando la

representacién “fpar” y revise los valores obtenidos.

B

Expression:

(((1+(@1)/(1-217)/4.05)-0. 2666 ;I
|

Start Band 1 33 End Band |12 33

Input MapLists 3

Meplist@1  [@nchi_07 =] J

Cutput MapList |fpar

Description:

Show | Defing | Cancel |

Figura 8.5: Célculo de fPAR para todo la lista de mapa NDVI

El rango de datos de fPAR debe estar entre 0 y 0.95 segln Potter et al. (1993). Por esa razén, los

mapas iniciales de fPAR deben corregirse siguiendo la siguiente condicidn: si fPAR < 0, fPAR=0 vy si
fPAR 20.95, fPAR=0.95. Para corregir los mapas de fPAR seleccione del menu de ILWIS “Operations =>
Raster Operations => Maplist Calculation”. Especifique la expresion indicada en la figura 8.6 y

presione “Show” para ejecutar la operacién.

Lﬁ; MaplList Calculation x|
Expression:
iff{ (@1 <=0,0,iff{(@1»=0.95.095.@1)) =
=
Start Band 1 = EndBand 125
Input MapLists 1 33
hapList (21 I@fpar jJ
Cutput MapList |fpar7fin
Description:
L
Show | Defing | Cancel |

Figura 8.6: Célculos para corregir la lista de mapa de fPAR
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A continuacion debera calcularse el PAR absorbido o APAR (ver paso 8 en el esquema de la figura
8.1) multiplicando los mapas de fPAR mensual por el correspondiente mapa de PAR mensual. Para
ello, cree una nueva lista de mapa usando los mapas mensuales de PAR remuestreados. Desde el
menu principal de ILWIS, seleccione “File => Create => Maplist” y agregue todos los mapas
remuestreados “PAR_*r” en orden secuencial a la lista de la derecha utilizando el icono “>”.
Especifique el nombre de la lista de mapa como “PAR_07” y presione “Ok”. Despliegue la nueva lista
de mapa creada como secuencia animada, utilizando la representacidon “Pseudo” y revise los valores
obtenidos.

|8 MapList Calculation

i apar_I: fpar_fin_1*par_0107r - ILWIS

EIRER 1=l

Exaression [DO/% 7R &4 ® = @ [T ]

-
Start Band 1 33 EndBand |12 3:

Input kapLists 2 3:

hapList @1 i fpar_fin 'ﬂ

MapList @2 i par_07r - J

Output MapList
Description:

Show | Define | Cancel |

BATRENT [STOTISES, B STW. 'WS-MWS-QW\; 4
Figura 8.7: Calculos realizados con la lista de mapa para obtener APAR y mapa resultante para
enero de 2007.

El siguiente paso es calcular la ANPP mensual (por ejemplo para enero de 2007, ver paso 9 de la
figura 8.1) multiplicando el mapa de APAR con el correspondiente mapa estacional de la RUE. Note
que debe elegir la estacién correspondiente segin cada mes. Elija “rue_sprsumr” para el cdlculo de la
ANPP desde octubre a marzo y “rue_autwinr” de abril a septiembre.

Los cdlculos deben repetirse para todos los meses, para ello cree un “script” y ejecutelo desde la
linea de comandos de ILWIS. Para crear un “script”, seleccione desde el menu principal de ILWIS “File
=> Create => Script”. Seleccione la lenglieta “Script” en el editor y tipee el contenido indicado en la
figura 8.8 (izquierda). Note que la primera linea es un comentario; la segunda linea define el célculo a
realizar. Se utilizan tres pardmetros: representados por %1 a %3. Abra la lenglieta “Parameters” para
definir los mapas de entrada y salida que serdn utilizados. Indique el contenido como se muestra en
la figura 8.8 (derecha). Una vez completado seleccione “Save” desde el menu y guarde el “Script”
como “ANPP_Calc”. Para ejecutarlo presione “>” desde el menu e indique los mapas de entrada y
salida. Presione “Ok” para ejecutarlo. En la figura 8.9 se muestran los detalles para el mes de enero.
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-loi -ii
File Edit Wiew Help File Edit Wiew Help

J Description | ‘ I Description | |
EEDEE T EEREEERIEE

[ scriot | Parameters [ Detauit Values | Farameters | Defaut Valuss

\Calculate monthly ANPP =l a

Number of Parameters |3 3:

Narme Type
Parameter %1 [APAR_input |nnagtE,Map j ™ Include Extensian

Parameter %22 |RUE_input InﬂagtErMap j ™ Include Extension
Parameter %3 [output mapnam I String j

| s |
A

A VA

243:=061"262"10

Figura 8.8: Script de ILWIS para el calculo de la ANPP mensual

L script "anpP_calc” x|

APAR_input Imaparj j
RUE_input Iﬂrue_spraumr j

outaut mapname
oK Cancel | Help |

Figure 8.9: Definiciéon de pardmetros en el script de ILWIS para el calculo de ANPP

Cuando haya finalizado los célculos, abra el mapa de ANPP creado, llamado “anpp_1" usando la
representacion “Pseudo”. Los resultados deben ser similares a los de la figura 8.10.

.
[2491,962 [STIOMETE, A ITIATIW [ STOI0L16°E, ATV IATIW ¢

Figura 8.10: Mapa de ANPP calculado para el mes de enero de 2007

Como esta operacién debe repetirse once veces, utilice la historia de la linea de comandos. Desde
el mend principal de ILWIS seleccione la linea de comandos con la flecha hacia abajo correspondiente
al calculo precio. La linea se muestra a continuacion:

Run ANPP_calc apar_1 rue_sprsumr “anpp_01"
Modifique la linea como se indica a continuacidn para ejecutar el cdlculo para el mes de febrero:

Run ANPP_calc apar_2 rue_sprsumr “anpp_02"
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Repita el procedimiento descripto arriba para calcular la ANPP de los meses restantes. Note una
vez mas que para los meses de octubre a marzo, debe utilizar "rue_sprsumr" y para los meses de
abril a septiembre "Rue_autwinr".

Una vez calculados los mapas mensuales de ANPP, deben ser integrados en un mapa anual (paso
10 del esquema de la figura 8.1). Para calcular el mapa ANPP_2007 debe crearse una nueva lista de
mapa. Desde el menu principal de ILWIS, seleccione “File => Create => MaplList” y agregue todos los
mapas “ANPP_*” en orden secuencial a la lista de la derecha utilizando “>”. Especifique como
nombre de la lista de mapa “ANPP_2007" y presione “Ok”. Despliegue la nueva lista de mapa
creada“ANPP_2007” como secuencia animada, utilizando la representacion “Pseudo” y revise los
valores obtenidos en el mapa. Cierre el mapa si ha visto la secuencia animada. Haga click con el
botén derecho del ratén sobre “ANPP_2007” y selecciones del menu contextual la opcidén “Statistics
=> MaplList Statistics”, utilice “Sum” como Statistical Function y especifique como nombre de salida
del mapa “anpp_sum”, presione “Show” para ejecutar la operacion.

Cuando los cdlculos han sido terminados, abra el nuevo mapa creado “anpp_sum”. El mismo
muestra la ANPP en Kg/ha para el afio 2007. Utilice la representacion “Pseudo”. Puede agregar una
capa con los limites del pais a este mapa final. Para ello, selecciones desde la ventana del mapa
activo la opcion “Layer => Add Layer” e indique el directorio de ILWIS, selecciones el subdirectorio
Extensions\Geonetcast-Toolbox\util\maps y seleccione el vector “country_02” y presione “Ok”. Quite
la seleccidon de la opcién “Info” y seleccione “Boundaries Only” y presione “Ok”. Mueva el ratén con
el botén izquierdo presionado sobre el mapa y revise los valores obtenidos. Los resultados deben ser
similares a la figura 8.11.

i anpp_sum: MapMaplistStatistics(anpp_07.mpl, Sum, 0, 11) - ILWIS _|ol x|
File Edit Layers Options Help

|00 A O & &y @ = [ [oumss

[ Jso00.0000 |

10000.0000
15000.0000
[20000.0000 |

[2476,2915 | 37°0808,2'S, 56°03'12.95"W | 37°08'06,25°S, 58°0312.95"W 7

Figura 8.11: Mapa final de ANPP para el afio 2007.

8.5 Conclusiones

Una metodologia para calcular la ANPP mensual en la region de Pampa de NDVI y datos PAR fue
presentada en este ejercicio. La metodologia se basa en el modelo de eficiencia con bi-estacional
mapas de la RUE. La validacién se llevé a cabo con anterioridad comparando los datos de ANPP
obtenidos con el modelo tradicional de Kumar y Monteith (1982) que utiliza un valor fijo RUE (en este
caso, 0,48 g / MJ). Ambos modelos fueron validados con tres conjuntos de datos mediante regresion

lineal simple usando los coeficientes de determinacidon (R2) y las pendientes para todas las
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comparaciones. Los tres conjuntos de datos independientes fueron: estimaciones de campo de la
ANPP , estimaciones de ANPP realizadas a partir de un modelo de precipitaciones (Sala et al 1988) y
estimaciones de ANPP a partir del modelo CASA (Imhoff et al. 2004). Para mas detalles ver Cristiano
et al. (2011). Ambos métodos (RUE variable y RUE fija) presentaron un bajo nivel de ajuste en
comparacion con la productividad observada en el campo (R2 = 0,25 y 0,30, respectivamente). Esto
puede ser debido a que los sitios considerados presentaban las mismas las condiciones ambientales.
Cuando se utilizaron los datos cubriendo todas las condiciones ambientales (ANPP obtenidos por las
lluvias y el modelo CASA), el nivel de ajuste aumentd significativamente y el R2 fue mayor en el
modelo de RUE variable que en el modelo RUE fija. Esto indica que el nUmero pequefo de sitios
considerados no reflejo la variabilidad en las condiciones ambientales necesarias para una correcta
validacién. Creemos que es necesario realizar una adecuada validacion del modelo con mas datos de
ANPP tomados a campo cubriendo toda la gama de condiciones ambientales estudiadas. En este
ejercicio se hace uso del NDVI obtenido a partir de MODIS TERRA. Actualmente en el GEONETCast-
DevCoCast también provee los productos de NDVI, al igual que el NDVI decadico derivada de SPOT-
Vegetation o los productos de NDVI diarios de SEVIRI a bordo de Meteosat-Segunda Generacién. Este
es un nuevo producto que se genera diariamente por Meteorological Product Extraction Facility.
Todos

estos productos pueden ser facilmente incorporados en el andlisis utilizando las rutinas de
importacion disponibles de la caja de herramientas de GEONETCast.
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9.1. Relevancia de la aplicacion

La evapotranspiracion (ET) es el término usado para describir la cantidad de agua, expresada en mm/d,
efectivamente perdida desde la superficie terrestre por evaporacion y transpirada por las plantas. Luego de
la precipitacion, la ET es el mayor componente del ciclo del agua terrestre, devolviendo a la atmdésfera mas
del 60% del agua recibida por precipitacion (Mu et al. 2011). Debido a su importancia en el ciclo hidroldgico
se hace necesaria su precisa cuantificacion para su uso tanto en la planificacién y manejo de los recursos
hidricos como en la produccidon agricola. Técnicas convencionales tales como Bowen ratio, eddy
covariance o lisimetros, han sido ampliamente usadas para estimar la ET sobre areas homogéneas a
escala de campo (e.g. Gowda et al. 2007). A pesar de su precision, estos sistemas solo proveen
informacién a escala local y son dificiles de extrapolar sobre areas heterogéneas. A escalas regional y aun
nacional, muchos paises han adoptado el método propuesto por la FAO (Allen et al. 1998), basado en la
ecuacién de Penman-Monteith. Sin embargo esta metodologia requiere la recopilacién de una gran
cantidad de informacién meteorolégica y parametros del tipo de la vegetacion, muchas veces dificiles de
obtener en forma representativa. En este sentido, actualmente los sensores remotos son reconocidos como
una herramienta valiosa capaz de proveer estimaciones espacialmente explicitas de ET, tanto a escala
local como regional (e.g. Di Bella et al. 2000, Coureault et al. 2003, Gowda et al. 2007, Mu et al. 2011).

9.2. Objetivo de la aplicacién

El objetivo de este trabajo fue desarrollar rutina automatica para la generaciéon de un producto de ET
utilizando informacion espectral derivada de los sensores MODIS e informacion meteorolégica. Aplicando
el método simplificado (Carlson et al. 1995, Jackson et al. 1997), se estimo6 la ET para la region central de
la Argentina con una resolucion espacial de 1km2 y temporal de 8 dias.

9.3. Informacién utilizada
9.3.1. Datos locales - Regionales (in-situ)
Los datos iniciales usados para derivar la evapotranspiracion (ET) son (Tabla 9.1):
e Temperatura de superficie (LST) derivado del producto MODIS Land Surface Temperature and
Emissivity (MOD11A2): mod11a2.2009145.LST_Day_1km.tif;
e Reflectancia espectral de superficie derivado del producto MODIS Surface Reflectances (Bandas 1
y 2 MODO09A1): mod09a1.2009145.sur_refl_b01.tif (b01: banda 1 - rojo y b02: banda 2 - infrarrojo
cercano);
e Temperatura del aire derivado de estaciones meteoroldgicas pertenecientes al Servicio
Meteoroldgico Nacional (SMN) e INTA: airtemp.2009145.tif;
¢ Modelo digital de elevaciones derivado de Shuttle Radar Topography Mission (SRTM);
e Radiacién neta: netrad.2009145.tif (producido por INTA siguiendo la aproximacion propuesta por
Kumar et al. (1997)).

Tabla 9.1. Caracteristicas de las bases de datos

Resoluciéon | Resolucion . Factor de
Producto . Unidades Fuente
temporal especial escala
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Temperatura
de superficie
Reflectancia
de superficie
(bandas 1y
2)
Temperatura
del aire
Radiacion
neta
(* Warehouse Inventory Search Tool available at https://wist.echo.nasa.gov/api/ and 2 produced at INTA)

8 dias 1 km Kelvin 0.02 MODIS'

8 dias 500 m Reflectancia 0.0001 MoDIS'

8 dias 500 m Celsius - INTA

8 dias 500 m MJ m-2 d-1 - INTA

9.3.2. Informacion derivada de GEONETCast — DevCoCast

Aunque la metodologia propuesta no utiliza informacién diseminada por GENETCast, INTA planea usar
algunos de sus productos en futuras versiones del producto. Cabe destacar que una limitante al uso de los
productos diseminados por GENETCast, es la cobertura parcial de area de interés.

9.4. Metodologia y descripcion del area de estudio

9.4.1. Metodologia

Para estimar la ET a escala regional se utilizara el método original propuesto por Jackson et al. (1977),
conocido como "Método Simplificado", el cual calcula la ET diaria (ETd en mmd-1) relacionando la
radiacién neta recibida por la superficie y su diferencia de temperatura con el aire subyacente segun:

ETd=NRd-B(Ts-Ta)n (Eq. 2)

donde NRd (mmd-1) es la radiacién neta diaria, Ts (K) es la tempertura de superficie, Ta (K) es la
temperatura del aire (cerca de la superficie), B (mmd-1K-1) y n son parametros que dependen del tipo y el
estado de la vegetacion. Aunque es un método relativamente simple, ha sido usado en la estimacion de la
ET de cultivos agricolas, forestaciones bosques nativos y pastizales, con muy buenos resultados (Seguin y
Itier 1983, Lagouarde y Brunet 1991, Courault et al., 1994, Caselles et al., 1998, Nosetto et al., 2005). El
producto de ET sera generado con una resolucion especial de 1km y temporal de 8 dias. La metodologia
completa es presentada en la Figura 9.1. La radiacién neta, la cual puede ser separada en radiacion neta
de onda corta (Sn) y radiacién neta de onda larga (Ln), es calculada usando la estimaciones de la radiacién
solar tedrica recibida (St) y el albedo de superficie (a). La radiaciéon neta de onda corta (Sn) es obtenida en
forma semi-empirica como:

Sn = St (1-a) (Eq. 3)

donde St es la radiacion tedrica incidente de onda corta y a es el albedo de superficie.

— —
Surface
Temperature . .
Digit_al N Incident g
Elevation *|  Radiation [ Net =
Model =
shortwave & | | Net N
longwave Radiation = =
surface | T radiation = ;
Reflectance A =
=
SATTELITE NDVI ce=
DATA =
~ °
—— Scaled NDVI B &n o
\ J|=
Air =
Temperature
GROUND
DATA

| S—
Figura 9.1. Diagrama de flujos de la cadena de procesamiento del producto propuesto.
Siguiendo a Kumar et al. (1997), St es calculada como la radiacién solar potencial recivida bajo condiciones de
cielo despejado en respuesta a la latitud y la elevacion, usando un modelo digital de elevaciones e infomacion de
a latitud, para estudiar la variacion en la radiacioén para diferentes orientaciones y pendientes del terreno. El
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albedo de superficie (a) es estimado usando los valores de reflectancia a partir de las bandas 1 (620-670 nm), 2
(841-876 nm), 3 (459-479 nm), 4 (545-565 nm), 5 (1230-1250 nm) and 7 (2105-2155 nm) del instrument MODIS-
TERRA, basado en la aproximacion propuesta por Liang (2000):

a =0.160a1+0.29102+0.243a3+0.116a4+0.11205+0.081a7-0.0015 (Eq. 4)

donde a (1 to 7) son los valores de reflectancia a partir de las respectivas bandas de MODIS-TERRA. La
radiaciéon neta de onda larga (Ln) es estimada empiricamente de acuerdo a Granger y Gray (1990). Asumiendo
que las variaciones en la humedad atmosférica son controladas por la energia disponible en la superficie
terrestre (NR), para condiciones de cielo despejado y a escala diaria, Ln puede ser estimado a partir de la
radiaciéon de onda corta incidente (St) como:

Ln = -4.25-0.24St (Eq. 5)

Debido a la falta de validacién de esta estimacion se planea usar en futuras versiones del producto, informacion
diseminada via GEONETCast, tal como Downward Surface Short-wave Flux and Downward

Surface Long-wave Flux, para estimar la radiaciéon neta siguiendo la metodologia propuesta por LSA-SAF en su
producto de ET (http:/landsaf.meteo.pt). Entonces, ambos aproximaciones seran comparados y se decidira
utilizar el método que mejor se ajuste a datos de radiacion neta tomados a campo.

La temperature de superficie (Ts) es obtenida de del producto de MODIS Land Surface Temperature and
Emissivity, mientras que la temperatura del aire cerca de la superficie (Ta) es derivada de las estaciones
meteoroldgicas presentes en el area de estudio.

El parametro B representa la conductancia promedio diaria del flujo de calor sensible y n es un factor de
correccién para condiciones no neutrales de estabilidad atmosférica (Kalma et al., 2008). Mientras B depende de
la rugosidad de la superficie, n depende de la estabilidad de la atmésfera y ambos coeficientes estan
estrechamente relacionados con la cantidad de vegetacion o la fraccion de suelo cubierto por la vegetacion, la
cual puede ser estimada a partir del indice de vegetacion escalado, conocido como Scaled Normalized
Vegetation Index or NDVI* (Carlson et al., 1995), donde:

NDVI* = (NDVI-NDVImin)/(NDVImax-NDVImin) (Eq. 6)

El indice de Vegracién de diferencia Normalizada (NDVI) también puede ser obtenido del producto NDVI de
MODIS. Finalmente, B y n seran calculados siguiendo las ecuaciones propuestas por Carlson et al. (1995),
donde:

B = 0.0109+0.051(NDVI*) (Eq. 7)
n = 1.067-0.372(NDVI*) (Eq. 8)

9.4.2. Area de estudio

El area de interés (Figura 9.2) incluye la porcion central del territorio argentino. Esta area abarca los territorio de
9 provincias, incluyendo: Buenos Aires, Entre Rios, Santa Fe, Cérdoba, La Pampa, San Luis, San Juan, La Rioja,
Rio Negro and Neuquén. De este a oeste, esta region presenta amplios gradientes climaticos, de tipos de suelo y
usos de la tierra.
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Figura 9.2. Area de estudio. Los triangulos muestran la ubicacion de las estaciones meteoroldgicas utilizadas
para estimar la ET.

9.5. Pre-procesamiento de la informacién

9.5.1. Informacién derivada de sensores remotos

Como se mencion6é mas arriba, en la ecuaciéon 2 la temperatura de superficie (Ts), el NDVI (necesario para
calcular los coeficientes B y n) y los valores de reflectancia espectral de superficie (necesario para calcular el
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albedo en la estimacién de la radiacion neta) son obtenidos de los productos MODIS-TERRA. Especificamente,
se hace uso de los productos Surface Spectral Reflectance 8-day L3 Global 500m (MOD9A1) y Land Surface
Temperature/Emissivity 8-day L3 Global 1km (MOD11A2). Para cubrir el area de interés en su totalidad fueron
utilizados dos escenas MODIS: h12v12 y h12v13.

La temperatura de superficie necesita ser remuestreada para obtener un tamafo de pixel de 500m, en
coincidencia con la resolucion espacial del producto MOD09A1.

Antes de arribar al calculo de ET es necesario importar y pre-procesar las imagenes utilizadas.

Copie y descomprima en su disco local c:\ el ejercicio (chapter9.zip). En su disco local c:\ usted ahora debe tener
una carpeta llamada “chapter9” conteniendo los siguientes subdirectorios: ‘Datalnput’ y ‘Working_Dir’. La carpeta
Datalnput contiene los siguientes sub-directorios: ‘1_SufraceTemp’, ‘2_SurfaceReflect’, ‘3_AirTemp’ and
‘4 _NetRad’. Abra el ILWIS y use el navegador para dirigirse al directorio “C:\Chapter9\Working_Dir”.

9.5.1.1. Importar y re-escalar el producto LST de MODIS

Para importer todas las imagenes necesarias de LST MODIS (mod11a2*.tif) con el propésito de estimar ET para
un periodo de tiempo usando el menu contextual de ILWIS puede ser algo incomodo. Use el explorador de
Windows para conocer el contenido del subdirectorio: "C:\chapter9\Datalnput\1_SurfaceTemp”. Alli se encuentran
4 archivos. El archive “SurfaceTemp.rar” contiene las imagenes originales de temperatura de superficie (LST) en
formato TIFF para 4 fechas consecutivas. Con el propédsito de importar esas imagenes en forma automatica, en
el mismo directorio se encuentran dos archivos *.bat “multi_import SurfaceTemp_start.bat” and
“multi_import_SurfaceTemp.bat”.

El contenido de esos archivos puede verse en las figuras 9.3 y 9.4. Haga click derecho en el archivo
“multi_import_SurfaceTemp_start.bat” y seleccione editar para visualizar el contenido del archivo.

B multi_impert_SurfaceTemp_start.bat - Notepad Q@g
Fle Edb Format Vew Help

echo set IlwisDir=%l>import_param.bat
echo set ChapterDir=%2>>import_param.bat

Rar.exe e surfaceTemp.rar

for %%j in (modlla2*.tif) do cmd /c multi_import_surfaceTemp.bat %%j

Figura 9.3. Archivo “batch” para iniciar la importacion de multiples imagenes en forma automatica.

Este archive establece en su primera linea se creara un nuevo archivo *.bat, llamado “import_param.bat”
especificando la ubicacién de su directorio ILWIS. La segunda linea agrega otro archivo *.bat,
“import_param.bat”, especificando la ubicacion del directorio donde usted ha descomprimido el ejercicio. La linea
3 especifica que el contenido del archivo “SurfaceTemp.rar” debe ser extraido y escrito en el mismo directorio. La
Ultima linea establece que para todas las imagenes (ahora descomprimidas) llamadas “mod11a2*.tif’, otra rutina
de procesamiento (archivo “multi_import_SurfaceTemp.bat”) sera ejecutada.

E multi_import_SurfaceTemp.bat - Notepad Q@g|

Fle Edt Format Vew Help

@echo off

echo rem: Import Land Surface Temperature (°C) from MOD11lAZ MODIS
product

echo rem: sample file name = modlla?.2009145.LST_Day_1lkm.tif

echo on

set originalfilenane=%1
set shortfilenamel=%originalfilename:~0,15%
set shortfilename2=%originalfilename:~8,7%

call -import_param.bat

"%ITwisDir%\Extensions\Geonetcast-TooThox\GDAL\bin\gdal_translate.exe"
-of ILWIS "%ChapterDir%\DataInput\l_surfaceTemp\%originalfilenames"
"%ChapterDir%\DataInput\1l_surfaceTemp\%shortfilenamel%. imported.mpr"

"%ITwisDir%\ilwis.exe" -C "%ChapterDir%\Working_Dir\surfaceTemp_%
shor tfilename2%.mpr{dom=VALUE.dom;vr=-10.0:100.0:0.01}":=("%
ChapterDir%\Datalnputyl_surfaceTemp\%shortfilenamel%. imported ' #0.02)-
273.15

del %originalfilename%
del *imported.mpr.aux.xml
de1 modl1la2*.mp#

del1 modllaz2*.mpr

Figura 9.4. Archivo “batch” para importar las imagenes de temperatura de superficie.
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Esta rutina de procesamiento, la cual es ejecutada luego de que todas las imagenes son descomprimidas,
comienza con un comando ‘set’. Las imagenes son procesadas siguiendo esta rutina de a una por vez en funcién
de su nombre de archivo (%1). Dos porciones del nombre del archivo es usado para el procesamiento. EL
nombre sin extension (‘shortfilename1’) y la fecha de generacion del producto (‘shortflename2’). El préoximo
comando llama el archivo “import_param.bat” que ha sido creado en el paso anterior, definiendo la ubicacion de
“llwisDir” y “ChapterDir”. La proxima linea ejecuta el programa ‘gdal_translate.exe’ para importar a formato ILWIS
la imagen *.tif que esta siendo procesada, y la guarda en el mismo directorio. La proxima linea escala la imagen
importada alpicando un factor de escala de 0.02 y una ordenada al origen de 273.15, convirtiendo las unidades
de temperatura de Kelvin a Celsius. Note que la imagen final convertida, también es guardada en el directorio
“Working_Dir” (en este caso C:\Chapter9\Working_Dir).

Ahora dirijase al menu Inicio de Windows, selecciones Ejecutar y escriba ‘command.exe’ para correr los archivos
*.bat. En la nueva ventana de comandos abierta, navege hasta su directorio de trabajo (en este caso
‘C:\chapter9\Datalnput\1_SurfaceTemp’) y ejecute el archivo *.bat de importacion de las imagenes de
temperatura de superficie. Para conocer los comandos necesarios para navegar hasta la ruta de su directorio de
trabajo, y otros comandos DOS vea la Figura 9.5.

\WINDOWS\systemn3 2\cmd. exe

crosoft Windows XP [Uersion 5.1.2600]
(C) Copyright 1985-2001 Microsoft Corp.

M:\>c:

C:\>cd C:\chapter9\DataInput\1_SurfaceTemp

C:\chapterg\DataInput\1_SurfaceTemp>multi_import_SurfaceTemp_start.bat c:\ilwis c¢:\chapter9

Figura 9.5. Iniciando la importacion desde una ventana de comandos DOS.

Note que en la linea de comandos, el archivo “multi_import_SurfaceTemp_start.bat” sera ejecutado usando dos
parametros. El primer parametro especificado es “C:\llwis”. Este parametro indica la ubicaciéon del directorio
ILWIS en el sistema; en su caso este directorio puede ser diferente. En ese caso, usted debe especificar el
directorio correcto. El segundo parametro es “c:\chapter9”; éste indica la ubicacion del directorio donde se
encuentra el ejercicio. Si ha instalado el ejercicio en otro directorio, usted necesita corregir este parametro. Una
vez verificado que los parametros son correctos, presionar “enter” para ejecutar la rutina de procesamiento.

Una vez que la importacion haya finalizado, seleccionar desde la ventana principal de ILWIS la opcion “Window
=> Refresh”, entonces podra notar que han sido creados cuatro mapas de temperatura. Luego haga doble click
en uno de los mapas, por ejemplo “SurfaceTemp_2009145”, use “Pseudo” como representacion y presione OK
para visualizar el mapa. Muévase sobre el mapa con el mouse, manteniendo presionado el boton izquierdo, para
ver los valores de temperatura.

9.5.1.2. Importar y escalar el producto Reflectancia de Superficie de MODIS

Para importar todas las imagenes necesarias de Reflectancia de Superficie de MODIS (mod09a1*.tif), repita el
procedimiento descripto arriba y ahora use los datos del sub-directorio ‘C:\chapter9\Datalnput\2_SurfaceReflect'.
Tenga en cuenta que ahora en la linea de comandos debe escribir “multi_import_SurfaceReflect_start.bat c:\ilwis
c:\chapter9”. El archivo “multi_import_SurfaceReflect.bat” permite importar las imagenes *.tif a formato ILWIS y
escalar los valores de reflectancia (ver también Tabla 9.1 y Figura 9.6).

Una vez que la importacion haya finalizado, seleccionar desde la ventana principal de ILWIS la opcion “Window
=> Refresh”, entonces podra notar que han sido creados cuatro mapas de reflectancia mod09a12009***_b01 y
mod09a12009***_b02 maps (*** = dia juliano). Luego haga doble click en uno de los mapas, por ejemplo
“mod09a12009145_b01”, use “Pseudo” como representacion y presione OK para visualizar el mapa. Muévase
sobre el mapa con el mouse, manteniendo presionado el botén izquierdo, para ver los valores de reflectancia.
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P multi_import_SurfaceReflect bat - Notepad

Fle Edt Format vew Hep

Becho off
echo rem: Import Surface Reflectance from MODO9ALl MODIS product
echo rem: sample file name = mod09%al.2009145.sur_ref1_bol.tif

echo on

set originalfilename=%1

set shortfilenamel=%originalfilename:~0,15%
set shortfilenamez=%criginalfilename:~25,3%
set shortfilename3d=%originalfilename:-0,7%

set shortfilenamed=%originalfilename:~8,7%

call import_param.bat

"%ITwisDirs\Extensions\Geonetcast-Toolbox\GDAL\bin\gdal_translate.exe”
-of ILWIS "%ChapterDir%\DataInput\2_surfaceReflect\%originalfilename%”
"%ChapterDir%\DataInput\2_surfaceReflect\%shortfilenamel®.%
shortfilename2%. imported.mpr"

"HITwisDirs\ilwis.exe" -C "%Chapterpirf%\working_pir\%shortfilename3%%
shortfilenamed%_%shortfilename2%.mpr
{dom=VALUE.dom;vr=0.0:1.0:0.001}":=("%Chapterpir%k
\DataInputh2_surfaceReflect\%shortfilenamel%.%

shortfilename2%. imported'*0.0001)

del %originalfilename%
del *imported.mpr.aux.xml
del mod09al®.mp#

del mod0%9al*.mpr

Figura 9.6. Archivo “batch” para importar las imagenes de Reflectancia de Superficie

9.5.2. Informacién Meteorolégica

9.5.2.1. Importacion del producto de temperatura del aire

Se hace uso de registros de temperatura del aire a 1,5 m, provenientes de estaciones meteoroldgicas presentes
en el area de estudio. La temperatura del aire de cada estaciéon, con una resolucion temporal diaria, fue
promediada cada 8 dias. Esta informacion puntual asi resumida fue interpolada para cubrir la totalidad del area
de estudio, con el objetivo de obtener informacion de temperatura del aire con la misma resolucion espacial que
el resto de las variables derivadas de sensores remotos (500 m).

Para importar todas las imagenes de Temperatura de Aire necesarias (airtemp*.tif), repita el procedimiento
descripto arriba para importar los productos MODIS y ahora use los datos del sub-directorio
‘C:\chapter9\Datalnput\3_AirTemp. Tenga en cuenta que ahora en la linea de comandos debe escribir
“multi_import_ AirTemp_start.bat c:\ilwis c:\chapter9”. En este caso, la rutina “multi_import_AirTemp.bat” solo
convierte a formato ILWIS las imagenes tif (ver Figura 9.7).

Una vez que la importacion haya finalizado, seleccionar desde la ventana principal de ILWIS la opcién “Window
=> Refresh”, entonces podra notar que han sido creados cuatro mapas de temperatura del aire. Luego haga
doble click en uno de los mapas, por ejemplo “airtemp_2009145”, use “Pseudo” como representacion y presione
OK para visualizar el mapa. Muévase sobre el mapa con el mouse, manteniendo presionado el botén izquierdo,
para ver los valores de temperatura del aire.

B multi_impart_AirTemp. bat - Notepad

Fle BOE FOrmat View Hep

@echo off

echo rem: Air Temperature (°C) product from ground metecrological
stations

echo rem: sample file name = airtemp.2009169.tif

echo on

set originalfilename=%1

set shortfilename=%originalfilename:-0,15%
set shortfilenamel=%originalfilename:~0,7%
set shortfilename2=%originalfilename:~8,7%

call <dimport_param.bat
"%ITwisDir%\Extensions\Geonetcast-Toolbox\GDAL\binYgdal_translate.exe”
-of ILWIS "%ChapterDir%\DataInput\3_AirTemp\%originalfilename%" "
ChapterDir%\Working_Dir\%shortfilenamel%_%shortfilename2%.mpr"

del %originalfilename%
del "%ChapterDir%\working_oir\*.mpr.aux.xml"

Figura 9.7. Archivo “batch” para importar las imagenes de Temperatura del Aire

9.5.2.2. Importacion del producto de Radiacion Neta

Para importar todas las imagenes necesarias de Radiacion Neta (netrad*.tif), repita el procedimiento descripto
arriba para importar los productos MODIS y ahora use los datos del sub-directorio
‘C:\chapter9\Datalnput\4_NetRad’. El ultimo comando en el archivo ‘multi_import_NetRad.bat' reemplaza los
valores -999.9 por un digito que representa la ausencia de datos, en el caso de ILWIS ese digito es “?”. El
reemplazo es hecho utilizando una funcién IFF (ver Figura 9.8).
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D multi_import_NetRad. bat - Notepad

Fle B4t Format View Help

@echo off

echo rem: Import Net Radiation (M1/m2.d) product
echo rem: sample file name = netrad.2009145.tif

echo on

set originalfilename=%1

set shortfilename=%originalfilename:~0,14%
set shortfilenamel=%criginalfilename:~0,6%
set shortfilename2=%originalfilename:-7,7%

call import_param.bat

"%ITwisDir%\Extensions\Geonetcast-Toolbox\GDAL\binYgdal_translate.exe”
-of ILWIS "%ChapterDir%\Dataln ut\4_NetRad\%origina filename%" "%
Chapterpirk\DataInputh\4_NetRad\%shortfilename%. imported.mpr"”

"SITwisDird\ilwis.exe” -C "%ChapterDir%\wWorking_bir\%shortfilenamel%
_%shortfilename2%.mpr{dom=vVALUE.dom;vr=0.0:100.0:0.001}":=IFF('%
ChapterDir%\DataInputh4_NetRad‘\%shortfilename®%. imported' '=-999.9,0,'%
Chapterbir%\DataInputh\4_NetRad\%shortfilename%. imported')

del %originalfilename®
del *imported.mpr.aux.xml
del netrad.*.mpr

del netrad.*.mp#

Figura 9.8. Archivo “batch” para importar las imagenes de Radiacion Neta

Una vez que la importacion haya finalizado, seleccionar desde la ventana principal de ILWIS la opcion “Window
=> Refresh”, entonces podra notar que han sido creados cuatro mapas de temperatura del aire. Luego haga
doble click en uno de los mapas, por ejemplo “netrad_2009145", use “Pseudo” como representacion y presione
OK para visualizar el mapa. Muévase sobre el mapa con el mouse, manteniendo presionado el botén izquierdo,
para ver los valores de radiacion neta.

9.5.2.3. Remuestreo del producto LST de MODIS

Luego de importar todos los mapas de temperatura de superficie a formato ILWIS, es necesario resamplear esas
imagenes para obtener un tamano de pixel de 500 m. Para hacer esto es necesario tipear las siguientes
expresiones en la linea de comandos de la ventana principal de ILWIS:
Surfacetemp_2009145r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_
2009145, airtemp_2009145.grf,nearest)
Surfacetemp_2009153r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_
2009153,airtemp_2009145.grf,nearest)
Surfacetemp_2009161r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_
2009161,airtemp_2009145.grf,nearest)
Surfacetemp_2009169r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_
2009169,airtemp_2009145.grf,nearest)

Cuando haya finalizado haga doble click en uno de los mapas creados, por ejemplo “surfacetemp_2009145r",
use “Pseudo” como representacion y presione OK para visualizar el mapa. Muévase sobre el mapa con el
mouse, manteniendo presionado el botén izquierdo, para ver los valores de temperatura de superficie.

9.6. Calculo de ET

9.6.1. Calculo de Normalized Difference Vegetation Index (NDVI)

Calcular el NDVI usando los valores de reflectancia de los canales rojo (b01) e infrarrojo cercano (b02) obtenidos
del producto Reflectancia de Superficie de MODIS. Para hacer esto, seleccionar de la menu principal de ILWIS
las opciones “Operations => Raster Operations => Map Calculation”. Tipear el algoritmo correspondiente al
célculo del NDVI (Figura 9.9), especificar un nombre de salida (en este caso “ndvi_2009145”), seleccionar como
“Value” como dominio (“Domain”), especificar el rango de valores (“Value Range”) entre 0 y 1, y definir la
precision de los valores (“Precision”) en 0.001. Ejecutar el comando presionando ‘Show'. Visualizar el mapa
creado (“ndvi_2009145”) usando ‘NDVI1’ como representacion. Repetir el mismo procedimiento para calcular el
NDVI del resto de las fechas: 153, 161 y 169. Para realizar el procesamiento en forma eficiente, se aconseja
hacer uso del historial de la linea de comandos del ILWIS. Solo necesita cambiar el dia juliano en la ecuacion,
entonces presione ‘enter’ para ejecutar el comando y calcular el nuevo mapa de NDVI.
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ap Calculation

Expression
(mod039a12009145_b02-mod09a12009745_b01)/(mod09a12009145_b0Z+mod09al 2009145_b01)

Output Raster Map  [ndvi_2009145 |

Domain ]@)VALUE—LIJ Defaults
“alue Range 0.000 1.000

Precisian 0.007]

Description

Map will use § bytes per pixel

Show | Define ‘ Cancel I Help ‘

Figura 9.9. Ventana ‘Map calculation’ para calcular el NDVI

9.6.2. Crear Listas de mapas en ILWIS (‘Map Lists’)

Para calcular la ET de varias fechas en forma simultanea, es conveniente crear listas de mapas o ‘Map Lists’.
Con el propdsito de ejecutar una misma operacion varias veces, es necesario creae una lista de mapas para
cada uno de los productos importados que seran utilizados en el calculo de ET (surfacetemp_resampled, ndvi,
airtemp and netrad). Para crear una lista de mapas, seleccionar desde el menu principal de ILWIS la opcién “File
=> Create => Map List". Seleccionar la lista de capas (mapas) en el orden apropiado para incluir en la lista de
mapas, presionar el botdén “>” para mover los mapas a la lista de la derecha, especificar un nombre de salida
para la lista de mapas (en este caso usar “NDVI”), y ejecutar el comando presionando OK (Figura 9.10). Repetir rl
mismo procedimiento para crear una lista de mapas para cada dato de entrada, es decir para “surftempr”,
“airtemp” y “netrad”.

hap List [n dvi

Description ﬂ
FEAmod09a12009161_b02 A

FEmod09a12009169_b01
i mod09a12009169_b02

v

EAnetrad_2009145
£

oK |Cance|| Help |

Figura 9.10. Ventana Crear lista de mapas

9.6.3. Calculo del NDVI escalado (SNDVI)

Para calcular el SNVI a partir de la lista de mapas, seleccionar desde el menu principal de ILWIS la opcion
“Operations =>Raster Operations => Map List Calculation”. Tipear el algoritmo del mismo modo que en la Figura
9.11: (@1-MAPMIN(@1))/(MAPMAX(@1)-MAPMIN(@1)). Especificar un nombre a la lista de mapas de salida
(en este caso ‘SNDVI’) y ejecutar el comando presionando ‘Show’. Una vez que el célculo de la lista de mapas de
NDVI escalado finalizd, hacer doble click en uno de los mapas, por ejemplo “sndvi_1", usar “Pseudo” como
representacion y presionar OK para visualizar el mapa. Muévase sobre el mapa con el mouse, manteniendo
presionado el botén izquierdo, para ver los valores de SNDVI de superficie.
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L},‘;; MaplList Calculation

Expression
(@ 1-MAPMIN{E 1) (MAPMARE1)-MAPMIN{ET))

Start Band [ = EndBand [4_—
Input Maplists LEI

MapList @1 Erndvi - J

Output MapList  |sndvi

Description:

Show ‘ Define | Cancel

Figura 9.11. Calculo de la lista de mapas de SNDVI

9.6.4. Calcular By n

Para calcular B y n a partir de la lista de mapas de ‘sndvi’, seleccionar del menu principal de ILWIS la opcion
“Operations => Raster Operations => Map List Calculation”. Tipear el algoritmo como se indica en la Figura 9.12
(izquierda): 0.0109+(0.051*@1). Especificar un nombre a la lista de mapas de salida (en este caso ‘B’) y ejecutar
el comando presionando ‘Show’. Siga el mismo procedimiento para calcular ‘n’, pero ahora aplique la férmula
como se indica en la Figura 9.12 (derecha): 1.067-(0.372*@1). Visualizar los resultados obtenidos utilizando
‘Pseudo’ como Representacion.

L i i Kﬂ 145 mapList Calculation
Expression Expression
0.0109+(0.051%81) 1.067-{0.372*@1)
Stan Band = EndBand [+ = Start Band ' = EndBand [t =
InputMaplise || = InputMapliste [ =
Maplist @1 [@en v];J Maplist @1 & 2ndhi - :J
Output MapList |8 | OutputMoplist | |
Diescriphon: Diescripion:
|compute B fiom sndvi [campute n tram snevi

Show | Detne | Cancel Shaw | Dene Cancal

Figura 9.12. Calculo de la lista de mapas de B (izquierda) y n (derecha)

9.6.5. Calcular diferencias de temperatura

Seguir el mismo procedimiento descripto arriba para calcular las diferencias de temperatura entre las listas de
mapas de temperatura de superficie (“surftempr”) y temperatura del aire (“airtemp”). Seleccionar del menu
principal de ILWIS la opcion “Operations => Raster Operations => Map List Calculation”. Tipear el algoritmo como
se indica en la Figura 9.13. En este caso use dos listas de mapas de entrada (‘Input MapList’), “surftempr” como
lista 1 y “airtemp” como lista 2. Especificar un nombre a la lista de mapas de salida (en este caso ‘tempdif’) y
ejecutar el comando presionando ‘Show’. Visualizar los resultados obtenidos utilizando ‘Pseudo’ como
Representacion.
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Lﬂ; MapList Calculation

Expression
E@1-@2

Start Band = EndBand 4_—
Input Maplists 2 =

MapList @1 B2 surftermpr - A
MapList @2 2 airtemp - A

Output MapList  ftermpdif

Description:

Show | Define | Cancel ‘

Figura 9.13. Calculo de la lista de mapas de ‘tempdif’

9.6.6. Calcular ET
Usando el calculador de listas de mapas (‘Map List Calculator’) aplicar la siguiente formula para calcular la
evapotranspiracion en mm d-1 (Figura 9.14): (@1*0.408)-(@2*(POW(@3,@4))). Note que los valores de

radiacion neta son afectados por el factor 0.408 (inversa del calor latente de vaporizacioén) para convertir las
unidades de MJ.m-2.d-1 a mm.d-1.

Lﬁ‘; MapList Calculation

Expression:
(@10 408)-(@2(POW(@3.@4)))

Stert Band [ = EndBand [4 =
Input Maplists ILE

MapList @1 ’mﬁ
MapList @2 ’@E—L|A
MapList @3 WJ
MapList @4 ’@w—L|A

Output MapList  [ET

Description
[Final ET computation, after Jackson etal 1977 |

Show | Define | Cancel |

Figura 9.14. Calculo de la lista de mapas de ‘ET’

Visualizar los resultados obtenidos utilizando ‘Pseudo’ como Representacion. Para el dia juliano 153, el mapa de
ET deberia parecerse al de la Figura 9.15. Desde la ventana activa seleccionar la opcién “Layers => Add Layer”,
navegar hasta la ubicacion “Extensions\Geonetcast-Toolbox\uti\maps” y seleccionar el vector “country_02”,
destildar la opcion “Info”, activar la opcién “Boundary Only” y presionar “OK”.

9.7. Verificar los resultados de ET

La validacion de los valores de ET es una tarea complicada. Al menos para evaluar si los resultados obtenidos
tienen sentido, fueron calculados los valores de evapotranspiracion potencial (ETP) de cada estacion
meteoroldgica siguiendo la metodologia Penman. Con este propésito se utilizaron datos de temperatura del aire,
velocidad del aire a 1,5 m, humedad relativa y heliofania efectiva. Los valores maximos diarios de ETP para cada

periodo de 8 dias fueron calculados. Estos valores pueden ser comparados con las estimaciones de ET
realizadas en este ejercicio.
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A ET_2: (netrad_2009153%0. 408)-(B_2*{POW{tempdif_2,n_2)}) - ILWIS
Fle Bt Layers Optiors M
DO & R & B @ [ri0seese)

‘MED etp_153 - Fo
o & Properties
IR w372
# ff Fropernes

1518,1341 35208, £2°10'B106°W | 39ME2A4E7S, 62010°51.09°W

Figura 9.15. Mapa de ET para el dia juliano 153

Abrir la tabla “etp_153" y revisar su contenido. Usted notara que existen diferencias notables entre los valores de
ET calculados por ambas aproximaciones (ETP y ET derivada de sensores remotos). En este caso, sélo se
usaran aquellas estaciones en que ambos valores son similares. Tipear la siguiente ecuacion en la linea de
comandos:

finalPet=iff(mean_ETP_Penmanmean_ETP_Thornthwaite<0.5,mean_ETP_Penman,?).

Presionar ‘Enter’ para ejecutar la operacion, aceptar las opciones por defecto y presionar ‘OK’. Una nueva
columna sera creada y los valores de esta columna podran ser comparados con los valores de ET estimados
mediante sensores remotos para el dia juliano 153, o ET_2 de la lista de mapas. Cerrar la tabla. Convertir la tabla
a un mapa de puntos. Para hacer esto, haga click derecho sobre la tabla “etp_153” y seleccione la opcion “Table
Operations => Table to Point Map”. Como sistema de coordenadas seleccione “airtemp_2009145” y como mapa
de salida ingrese el nombre “etp_153". Presione “Show” para ejecutar la operacién. Visualice el mapa creado y
cierre la ventana. Desde la ventana de mapa activa utilizada para visualizar el mapa “ET_2” seleccione la opcién
“Layers=> Add Layer”, navegue en el directorio ILWIS, seleccione el mapa de puntos recién creado “etp_153",
active en el menu “Display Options” la opcién “Atribute”, seleccione la columna “final PET” y presione OK. Desde
la ventana de mapa activa, seleccione “File => Open Pixel Information”, muévase con el mouse sobre los puntos
en el mapa y observe los resultados en la tabla de informacion de pixel (“Pixel information table”). Cierre la capa
de mapa activa. Convierta el mapa de puntos “etp_153” a formato raster. Haga click derecho con el mouse sobre
el mapa de puntos “etp_153", y seleccione “Rasterize => Point to Raster”. Selecciones “airtemp_2009145” como
sistema de referencia (“Georeference”) y como nombre de salida del mapa raster ingrese “etp_153". Presione
“Show” para ejecutar la operacion. Usted puede acercar la vista del mapa usando la herramienta de “zoom” para
ver los resultados.

Desde el menu principal de ILWIS seleccionar “Operations => Raster Operations => Cross”. Como primer mapa
elegir “ET_2", como Segundo mapa seleccionar la columna de atributos “finalPet”. Para hacer esto haga click en
el sigo “+” delante del mapa “etp_153" para seleccionar la columna apropiada. Como tabla de salida especificar.
Como tabla de salida (“Output Table”) ingresar “compareETp_Eta” y presionar ‘Show’. Desde el menu de la
nueva tabla creada seleccionar el icono “Graph”, como eje X elegir “map2” (valor de ETP (Penman) resultante de
la tabla de atributos) y como eje Y seleccionar “ET_2”", y presionar OK. Haga doble click en el icono X-Axis para
especificar el rango de valores del eje (0 a 2, intervalo: 0,5) y presione OK. Repita la operacion para el eje Y.
Destilde la opcion “Legend”. Haga doble click sobre el icono “map2 * ET_2” y cambie el color tranparente por
rojo. El grafico resultante deberia parecerse al de la Figura 9.16.
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Figura 9.16. Comparacion de los valores de ET estimados con sensores remotos y la ETP calculada para el dia
juliano 153

9.8. Conclusiones

En la Figura 9.16 puede verse que los valores de ET estimados mediante el uso de sensores remotos son
menores a la ETP calculada con datos meteoroldgicos, lo cual coincide con lo esperado.

Con el propésito de validar las estimaciones de ET, INTA usara datos de ET medidos mediante el uso de torres
“eddy covariance” y calculos de ET a partir de informacion meteoroldgica. Actualmente el INTA tiene acceso a
datos de ET medidos con tres torres eddy covariance, ubicadas en sitios cubiertos por coberturas vegetales
representativas (bosques nativos, forestaciones y agricultura). Ademas, en el futuro se utilizaran datos
meteoroldgicos provenientes de 150 estaciones instaladas por el INTA a lo largo de todo el territorio argentino.
Para considerar posibles errores en los valores de las variables de entrada utilizadas (NR, B, n and Ts-Ta) para
el calculo de ET, se testeara la sensibilidad de las estimaciones de ET explorando los posibles efectos de valores
extremos de dichas variables.
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